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คำนำ 
 

 กลุ มนว ัตกรรมและเทคโนโลยีการศึกษา ส ํานักว ิทยบริการและเทคโนโลยีสารสนเทศ 

มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร มีภาระกิจหลักในการสนับสนุน ผลิตและพัฒนานวัตกรรม                             

สื่อการเรียนการสอน พัฒนาระบบการเรียนการสอนโดยใชเทคโนโลยีสารสนเทศ รวมถึงการสนับสนุน เผยแพร

และประชาสัมพันธกิจกรรมตาง ๆ  ของทางมหาวิทยาลัย สําหรับการผลิตภาพกราฟกเปนสวนหนึ่งในการ

เผยแพรและประชาสัมพันธมหาวิทยาลัย คูมือการปฏิบัติงานการผลิตภาพกราฟกในการถายทอดสดผานระบบ

อินเทอรเน็ตเลมนี้ จึงเปนคูมือการปฏิบัติงานสำหรับเจาหนาที่กลุมนวัตกรรมและเทคโนโลยีการศึกษา      

สํานักวิทยบริการและเทคโนโลยีสารสนเทศ มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร เพื่อใชเปนแนวทาง   

ในการปฏิบัติงานใหกับเจาหนาที่สามารถปฏิบัติงานแทนกันไดและใหการปฏิบัติงานเปนไปในทิศทางเดียวกัน 

โดยผูจัดทําคูมือปฏิบัติงานไดรวบรวมความรูประสบการณในการทํางานและไดศึกษาเพิ่มเติมจากแหลงขอมูล 

ตาง ๆ เพื่อใหคูมือปฏิบัติงานเลมน้ีสมบูรณ นำไปใชในการปฏิบัติงานไดจริงและเกิดประสิทธิภาพสูงสุด 
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 นักวิชาการชางศิลปปฏิบัติการ 

 



สารบัญ 
        หนา 

บทที่ 1 บทนํา           1 

1.1 ความเปนมาและความสําคัญ        1 

1.2 วัตถุประสงค          2 

1.3 ประโยชนที่คาดวาจะไดรับ        2 

1.4 ขอบเขตของคูมือ         2 

1.5 คําจํากัดความเบื้องตน        2 

บทที่ 2 โครงสรางและหนาที่ความรับผิดชอบ       3 

2.1 โครงสรางการบริหารจัดการ        5 

2.2 บทบาทหนาที่ความรับผิดชอบ        10 

บทที่ 3 หลักเกณฑวิธีการปฏิบัติงาน        14 

3.1 องคประกอบศิลป         15 

3.2 หลักการออกแบบ         21 

3.3 คุณสมบัติที่ควรรูของโปรแกรม Adobe Photoshop cc     24

 3.4 สวนประกอบในหนาตางของโปรแกรม Adobe Photoshop cc    33 

3.5 คียลัดในการใชงานของโปรแกรม Adobe Photoshop cc    48 

3.6 ขอควรระวังในการปฏิบัติงาน        56 

บทที่ 4 เทคนิคการปฎิบัติงาน         57 

4.1 การสรางไฟลเอกสารใน Adobe Photoshop cc     57 

4.2 การผลิตภาพกราฟกภาพพักหนาจอ       64 

4.3 การผลิตภาพกราฟกแถบชื่องาน       82 

4.4 การผลิตภาพกราฟกแถบชื่อผูรวมงาน       91 

4.5 การบันทึกไฟลภาพกราฟก        100 

4.6 การติดตามประเมินผลการปฏิบัติงาน       105 

บทที่ 5 ปญหา อุปสรรคและขอเสนอแนะ        106 

5.1 ปญหาอุปสรรค         106 

5.2 แนวทางการแกไขปญหา        107 

5.3 ขอเสนอแนะ          109 

บรรณานุกรม           111 

 

 



สารบัญภาพ 
        หนา 

ภาพท่ี 2-1 แสดงโครงสรางหนวยงานของสํานักวิทยบริการและเทคโนโลยีสารสนเทศ   5 

ภาพท่ี 2-2 แสดงโครงสรางการบริหารสํานักวิทยบริการและเทคโนโลยีสารสนเทศ   6 

ภาพท่ี 2-3 แสดงโครงสรางการปฏิบัติงานกลุมพัฒนานวัตกรรมและเทคโนโลยีการศึกษา            7  

              สํานักวิทยบริการและเทคโนโลยีสารสนเทศ 

ภาพท่ี 2-4 แสดงแผนผังขั้นตอนการปฏิบัติงานการผลิตภาพกราฟกสําหรับการถายทอดสัญญาณภาพ 13  

              และเสียงออกอากาศผานทางระบบอินเทอรเน็ต 

ภาพท่ี 3-1 ลักษณะพิกเซลของภาพ        25 

ภาพท่ี 3-2 ตัวอยางภาพถายขนาด 4x6 น้ิว ความละเอียด 72 pixels/inch มีจํานวนพิกเซลทั้งหมด 26 

              124,416 pixels     

ภาพท่ี 3-3 การขยายภาพแบบ Bitmap จนเห็นพิกเซลเรียงตัวกันเปนตาราง     27 

ภาพท่ี 3-4 เปรียบเทียบความละเอียดของภาพระหวาง 72 ppi (ซาย) และ 300 ppi (ขวา)  28 

ภาพท่ี 3-5 Hue ที่แทนคาสีดวยองศา        29 

ภาพท่ี 3-6 แสดงความสดของสี         30 

ภาพท่ี 3-7 แสดงความสวางและความมืดของสี       30 

ภาพท่ี 3-8 การผสมสีแบบบวก (additive color mixing)      31 

ภาพท่ี 3-9 การผสมสีแบบลบ (Subtractive Color Mixing)      31 

ภาพท่ี 3-10 สวนประกอบของโปรแกรม Adobe photoshop cc     33 

ภาพท่ี 3-11 แถบคำสั่ง Menu Bar        34 

ภาพท่ี 3-12 การเลือกใชคำสั่งยอยใน Menu Bar       34 

ภาพท่ี 3-13 คียลัดที่ใชเรียกคำสั่งของ Menu Bar       35 

ภาพท่ี 3-14 Option Bar ของ Type tool        35 

ภาพท่ี 3-15 วิธีบันทึกคาเคร่ืองมือที่ตองใชเปนประจำ      36 

ภาพท่ี 3-16 เคร่ืองมือยอยของ Selection        41 

ภาพท่ี 3-17 ตัวอยาง Character Panel และ Swatches Panel     41 

ภาพท่ี 3-18 การยอ-ขยายของ Panel        42 

ภาพท่ี 3-19 การปด Panel         42 

ภาพท่ี 3-20 การซอน-แสดง Panel        43 

ภาพท่ี 3-21 การเรียกใชงาน Panel        43 

ภาพท่ี 3-22 การทำงานใน Workspace Essentials [Default]     44 

ภาพท่ี 3-23 การทำงานใน Workspace 3D       44 



สารบัญภาพ (ตอ) 
        หนา 

ภาพท่ี 3-24 การทำงานใน Workspace Graphic and Web     45 

ภาพท่ี 3-25 การทำงานใน Workspace Motion       45 

ภาพท่ี 3-26 การทำงานใน Workspace Painting       46 

ภาพท่ี 3-27 การทำงานใน Workspace Photography      46 

ภาพท่ี 3-28 การเรียกใชงาน Workspace โดยการคลิก Window ตรง Menu bar    47 

ภาพท่ี 3-29 การเรียกใชงาน Workspace โดยการคลิกปุม             มุมบนขวาของโปรแกรม  47 

ภาพท่ี 3-30 พื้นที่การทำงานของ Artboard       48 

ภาพท่ี 4-31 การต้ังคาไฟลเอกสาร         57 

ภาพท่ี 4-32 หนาตาง Preset         58 

ภาพท่ี 4-33 แสดงการใชงานไฟลลาสุด        58 

ภาพท่ี 4-34 ไฟลเอกสารที่ไดบันทึก         59 

ภาพท่ี 4-35 ขนาดของไฟลเอกสารที่โปรแกรมกำหนดไวในประเภท Photo     59 

ภาพท่ี 4-36 ขนาดของไฟลเอกสารที่โปรแกรมกำหนดไวในประเภท Print    60 

ภาพท่ี 4-37 ขนาดของไฟลเอกสารที่โปรแกรมกำหนดไวในประเภท Art & Illustration   60 

ภาพท่ี 4-38 ขนาดของไฟลเอกสารที่โปรแกรมกำหนดไวในประเภท Web    61 

ภาพท่ี 4-39 ขนาดของไฟลเอกสารที่โปรแกรมกำหนดไวในประเภท Mobile    61 

ภาพท่ี 4-40 ขนาดของไฟลเอกสารที่โปรแกรมกำหนดไวในประเภท Film & Video   62 

ภาพท่ี 4-41 รูปแบบตางๆ ที่โปรแกรมกำหนด       62 

ภาพท่ี 4-42 หนาตาง Preset Detail        63 

ภาพท่ี 4-43 ไฟลเอกสารที่สรางสำเร็จ        64 

ภาพท่ี 4-44 วิธีเปดโปรแกรม Adobe Photoshop cc      65 

ภาพท่ี 4-45 หนาจอเมื่อโปรแกรม Adobe Photoshop cc เปดใชงาน    65 

ภาพท่ี 4-46 การสรางไฟลเอกสาร         66 

ภาพท่ี 4-47 การต้ังคาไฟลเอกสาร         66 

ภาพท่ี 4-48 การกำหนดภาพพื้นหลังของไฟลเอกสาร      67 

ภาพท่ี 4-49 การต้ังชื่อไฟลเอกสาร        67 

ภาพท่ี 4-50 หนาจอแสดงไฟลเอกสาร Background  ที่ไดสรางไว     68 

ภาพท่ี 4-51 หนาจอแสดงการเปดไฟลรูป        68 

ภาพท่ี 4-52 หนาจอแสดงการเลือกไฟลรูป        69 

ภาพท่ี 4-53 รูปภาพที่เลือกในไฟลเอกสาร Background      69 



สารบัญภาพ (ตอ) 
        หนา 

ภาพท่ี 4-54 คลิกเลือก Layer รูปภาพ ใน Layer Panel      70 

ภาพท่ี 4-55 คัดลอกรูปภาพโดยใช Menu Edit       70 

ภาพท่ี 4-56 เลือกไฟลเอกสารที่ตองการวางรูปที่คัดลอกมา      71 

ภาพท่ี 4-57 วาง Layer ที่ Copy มา โดยใช Menu Edit      71 

ภาพท่ี 4-58 ไฟลรูปภาพในไฟลเอกสาร Background      72 

.ภาพท่ี 4-59 ใชคำสั่ง Edit -> Transform        72 

ภาพท่ี 4-60 การเลือก Move Tool         72 

ภาพท่ี 4-61 การจัดวางรูปภาพใหเหมาะสมกับขนาดของพื้นที่     73 

ภาพท่ี 4-62 ใส Filter Gaussian blur        73 

ภาพท่ี 4-63 กำหนดคา Radius ใน Filter Gaussian blur      74 

ภาพท่ี 4-64 รูปภาพที่ใส Filter Gaussian blur       74 

ภาพท่ี 4-65 Horizontal Type Tool ที ่Toolbox       75 

ภาพท่ี 4-66 Option bar กำหนดรายละเอียดของตัวอักษรกลุมชื่องาน    75 

ภาพท่ี 4-67 ขอความที่พิมพลงไป         76 

ภาพท่ี 4-68 ยายขอความโดยใช Move Tool       76 

ภาพท่ี 4-69 จัดแตงขอความโดยใช Character Panel       76 

ภาพท่ี 4-70 ขอความที่จัดแตงสำเร็จ        77 

ภาพท่ี 4-71 เรียกใชคำสั่ง Effect Stroke ที่ Menu Layer      77 

ภาพท่ี 4-72 เรียกใชคำสั่ง Effect Stroke ที่ Layer  Panel      77 

ภาพท่ี 4-73 กำหนดคาตางๆ ในหัวขอ Stroke       78 

ภาพท่ี 4-74 ขอความชื่องานที่จัดทำสำเร็จ         78 

ภาพท่ี 4-75 Option bar กำหนดรายละเอียดของกลุมขอความรายละเอียดของงาน   79 

ภาพท่ี 4-76 ขอความรายละเอียดของงาน        79 

ภาพท่ี 4-77 กำหนดคาในหัวขอ Stroke        80 

ภาพท่ี 4-78 ขอความรายละเอียดของงานที่จัดแตงสำเร็จ      80 

ภาพท่ี 4-79 ไฟลภาพพักหนาจอที่จัดทำสำเร็จ       81 

ภาพท่ี 4-80 ตัวอยางภาพพักหนาจอพิธีไหวครูในการถายทอดสดผาน Facebook live    81 

ภาพท่ี 4-81 ตัวอยางภาพพักหนาจองานปจฉิมนิเทศนักศึกษาในการถายทอดสดผาน Facebook live  82 

ภาพท่ี 4-82 เปดไฟลเอกสารที่ไดบันทึกไวโดยคำสั่ง Open      83 

ภาพท่ี 4-83 เลือกไฟลที่ตองการเปด        83 



สารบัญภาพ (ตอ) 
        หนา 

ภาพท่ี 4-84 ไฟลเอกสารที่ไดบันทึกไว        84 

ภาพท่ี 4-85 Rectangle Tool ที่ Toolbox       84 

ภาพท่ี 4-86 กำหนดคาของแถบชื่อที่ Option bar       85 

ภาพท่ี 4-87 หนาตางแสดงขนาดของแถบขอความที่ตองการสราง     85 

ภาพท่ี 4-88 สี่เหลี่ยมผืนผาที่สรางสำเร็จ        85 

ภาพท่ี 4-89 Move Tool สำหรับเคลื่อนยาย       86 

ภาพท่ี 4-90 เสนไกดแนวนอนเสนที่ 3        86 

ภาพท่ี 4-91 สี่เหลี่ยมที่ยายลงมาดานลาง        87 

ภาพท่ี 4-92 คำสั่ง Skew ที่ Menu Bar -> Edit       87 

ภาพท่ี 4-93 ปรับรูปทรงของสี่เหลี่ยมผืนผาใหเปนสี่เหลี่ยมเปยกปูน     88 

ภาพท่ี 4-94 สี่เหลี่ยมเปยกปูนที่สรางสำเร็จ        88 

ภาพท่ี 4-95 Horizontal Type Tool        88 

ภาพท่ี 4-96 Option bar กำหนดรายละเอียดของตัวอักษร      89 

ภาพท่ี 4-97 ขอความที่พิมพลงไป         89 

ภาพท่ี 4-98 ยายและจัดแตงขอความใหเหมาะสมดวย Move Tool  และ Character Panel  89 

ภาพท่ี 4-99 ขอความที่จัดแตงสำเร็จ        90 

ภาพท่ี 4-100 ตัวอยางกราฟกแถบชื่อการบรรยายในกิจกรรมปฐมนิเทศนักศึกษา    90 

                  ในการถายทอดสดผาน  Facebook live 

ภาพท่ี 4-101 ตัวอยางกราฟกแถบชื่องานในการสัมมนาผาน Facebook live    90 

ภาพท่ี 4-102 Rectangle Tool ที่ Toolbox       91 

ภาพท่ี 4-103 Option bar กำหนดรายละเอียดของสี่เหลี่ยมสีมวง     92 

ภาพท่ี 4-104 หนาตางแสดงขนาดของแถบขอความที่ตองการสราง     92 

ภาพท่ี 4-105 สี่เหลี่ยมสีมวงที่สรางสำเร็จ        92 

ภาพท่ี 4-106 Rectangle Tool ที่ Toolbox       93 

ภาพท่ี 4-107 Option bar กำหนดรายละเอียดของสี่เหลี่ยมสีขาว     93 

ภาพท่ี 4-108 หนาตางแสดงขนาดของแถบขอความที่ตองการสราง     93 

ภาพท่ี 4-109 สี่เหลี่ยมสีขาวที่สรางสำเร็จ        94 

ภาพท่ี 4-110 สี่เหลี่ยมสีขาวและสีมวง        94 

ภาพท่ี 4-111 Move Tool สำหรับเคลื่อนยายสี่เหลี่ยม      94 

ภาพท่ี 4-112 การเคลื่อนยายสี่เหลี่ยมสีขาว       95 



สารบัญภาพ (ตอ) 
         หนา 

ภาพท่ี 4-113 เลือก Layer สี่เหลี่ยมที่ตองการปรับรูปทรง      95 

ภาพท่ี 4-114 คำสั่ง Skew ที่ Menu Bar -> Edit       95 

ภาพท่ี 4-115 คลิกจุดตรงกลางเพื่อปรับรูปทรงของสี่เหลี่ยมผืนผาใหเปนสี่เหลี่ยมเปยกปูน  96 

ภาพท่ี 4-116 สี่เหลี่ยมเปยกปูนที่สรางสำเร็จ       96 

ภาพท่ี 4-117 Horizontal Type Tool        96 

ภาพท่ี 4-118 Option bar กำหนดรายละเอียดของตัวอักษร      97 

ภาพท่ี 4-119 ชื่อและนามสกุลของผูรวมงาน       97 

ภาพท่ี 4-120 Option bar กำหนดรายละเอียดของตัวอักษร      97 

ภาพท่ี 4-121 พิมพตำแหนงหรือหนาที่ของผูรวมงาน      98 
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บทที่ 1 

บทนำ 

1.1 ความเปนมาและความสำคัญ 

 สำนักวิทยบริการและเทคโนโลยีสารสนเทศ มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร เปนหนวยงาน

ที่สนับสนุนภาระกิจหลักของมหาวิทยาลัยในการนำนโยบายดิจิตัลเพื่อเศรษฐกิจและสังคม เขามามีบทบาทใน

การพัฒนากระบวนการจัดการศึกษา โดยใหบริการดานเทคโนโลยีสารสนเทศในการเรียนการสอน การ

คนควาวิจัย พัฒนาและผลิตสื่อสนับสนุนการเรียนการสอนที่มีคุณภาพ พัฒนาระบบการเรียนการสอนโดยใช

เทคโนโลยีสารสนเทศ และผลิตสื่อในทุกรูปแบบแกนักศึกษา คณาจารย และเจาหนาที่ของมหาวิทยาลัย

เทคโนโลยีราชมงคลพระนคร สำนักวิทยบริการและเทคโนโลยีสารสนเทศ ไดแบงโครงสรางการบริหารงาน

ออกเปน 5 กลุมงาน ไดแก กลุมวิทยบริการ กลุมพัฒนานวัตกรรมและเทคโนโลยีการศึกษา กลุมเทคโนโลยี

สารสนเทศ กลุมเครือขายคอมพิวเตอรและการสื่อสาร และงานบริหารทั่วไป กลุมพัฒนานวัตกรรมและ

เทคโนโลยีการศึกษา เปนหนวยงานที่มีภาระกิจหลักในการสนับสนุน ผลิตและพัฒนานวัตกรรมสื่อการเรียน

การสอน พัฒนาระบบการเรียนการสอนโดยใชเทคโนโลยีสารสนเทศ เชน ผลิตสื่อการเรียนการสอนทางไกล

ผานดาวเทียม สื่อ e-Learning รวมถึงสนับสนุน เผยแพรและประชาสัมพันธกิจกรรมตาง ๆ ของมหาวิทยาลัย 

ทั้งภายในและภายนอกองคกร เชน การบันทึกภาพเคลื่อนไหว การบันทึกภาพนิ่ง การบันทึกเสียง การผลิต  

สื่อวีดิทัศน การผลิตสื่อมัลติมีเดีย การผลิตสื่อสิ่งพิมพ งานถายทอดสดผานระบบอินเทอรเน็ต งานควบคุม

ระบบเสียง สำหรับการผลิตภาพกราฟกในการถายทอดสดผานระบบอินเทอรเน็ตนั้น เปนสวนหนึ่งของ      

งานถายทอดสดผานระบบอินเทอรเน็ต มีวัตถุประสงคเพื ่อเผยแพรและประชาสัมพันธก ิจกรรมตาง ๆ        

ของมหาวิทยาลัยใหเปนที่รูจัก 

 การผลิตภาพกราฟกในการถายทอดสดผานระบบอินเทอรเน็ต เปนการผลิตภาพกราฟกประกอบการ

ถายทอดสดผานระบบอินเทอรเน็ต เมื่อการถายทอดสดเร่ิมตนจะพบกับกราฟกภาพพักหนาจอ บอกชื่องาน 

วัน เวลาและสถานที่จัดงาน เปนภาพแบบเต็มหนาจอ เมื่อการถายทอดสดออกอากาศไปไดระยะเวลาหน่ึง   

จะมโีลโกมหาวิทยาลัยและโลโกกิจกรรมขนาดยอสวนขึ้นอยูที่มุมใดมุมหน่ึงของจอ เพื่อบอกใหผูชมรับทราบวา

กำลังรับชมกิจกรรมอะไรของมหาวิทยาลัยอยู หากในการถายทอดสดมีพิธีกรดำเนินรายการ มีประธานในงาน

หรือวิทยากรมาพูดใหความรู จะมีกราฟกบอกชื่อ นามสกุลและตำแหนง เพื่อเปนการใหเกียรติแกบุคคลน้ัน ๆ 

และบอกผูรับชมใหทราบวาเปนใคร นอกจากน้ียังมีกราฟกที่ม ีลักษณะเปนแถบเล็ก ๆ อยูดานลางจอ         

เปนกราฟกบอกชื่องาน จะขึ้นอยูเปนระยะ ๆ ในการถายทอดสด เพื่อใหผูชมที่เพิ่งเขามารับทราบวาน่ีคือ การ

ถายทอดสดงานใด ในสวนรูปแบบของภาพกราฟกที่ตองการนำเสนอขึ้นอยูกับความคิดสรางสรรคของผูสราง

งานและรูปแบบของกิจกรรมวาเปนกิจกรรมในรูปแบบใด มีการวางแนวทางงานกราฟก ไมวาจะเปนกราฟก

บอกชื่องาน โลโก โทนสี ลักษณะตัวอักษร รูปแบบของกราฟก จะตองมีความสอดคลอง เหมาะสมกับรูปแบบ

ของกิจกรรม สำหรับการผลิตภาพกราฟกในการถายทอดสดผานระบบอินเทอรเน็ตโดยการใชโปรแกรม 
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Adobe Photoshop cc นั้น ผูปฏิบัติงานจำเปนจะตองทราบถึงคุณสมบัติเฉพาะทางเทคนิคของโปรแกรม 

Adobe Photoshop cc ดังนั้นผูปฏิบัติงานที่มีหนาที่ที ่เกี่ยวของจำเปนจะตองศึกษาและมีแนวทางปฏิบัติที่

เปนไปในทางเดียวกัน เพื่อใหการผลิตภาพกราฟกมีมาตรฐานและเกิดประโยชนสูงสุดตอหนวยงานและ

มหาวิทยาลัย  

 จากความเปนมาและความสำคัญดังกลาว จึงไดจัดทำคูมือปฏิบัติงานเร่ืองการผลิตภาพกราฟกในการ

ถายทอดสดผานระบบอินเทอรเน็ตขึ้นมา เพื่อใหผูปฏิบัติงานสามารถปฏิบัติงานแทนกันไดและใชเปนแนวทาง

ในการปฏิบัติงานใหมีมาตรฐานและเปนไปในทิศทางเดียวกัน  

 

1.2 วัตถุประสงค 

1. เพื่อจัดทำคูมือการปฏิบัติงานการผลิตภาพกราฟกในการถายทอดสดผานระบบอินเทอรเน็ต 

2. เพ ื ่อใหผู ปฏ ิบ ัต ิงานทราบถึงขั ้นตอนในการผลิตภาพกราฟกในการถายทอดสดผานระบบ

อินเทอรเน็ต 

3. เพื่อใหผูปฏิบัติงานรูจักโปรแกรม Adobe Photoshop cc เบื้องตน 

  

1.3 ประโยชนที่คาดวาจะไดรับ  

1. ผูปฏิบัติงานสามารถปฏิบัติงานแทนกันได  

2. ใหการปฏิบัติงานมีมาตรฐานและเปนไปในทิศทางเดียวกัน 

3. ผูปฏิบัติงานมีความรูความเขาใจในโปรแกรม Adobe Photoshop cc เบื้องตน  

 

1.4 ขอบเขตของคูมือ 

  คู ม ือปฏิบ ัติงานเล มนี ้ ครอบคลุมข ั ้นตอนการผลิตภาพกราฟกในการถายทอดสดผานระบบ

อินเทอรเน็ต โดยใชโปรแกรม Adobe Photoshop cc ตั้งแตขั ้นตอนการเริ ่มตนสรางภาพกราฟ กด วย

คอมพิวเตอรจนสิ้นสุดกระบวนการในขั้นตอนของการบันทึกไฟลภาพกราฟกของเจาหนาที่ผูปฏิบัติงาน ทั้งจาก

หนวยงานภายในและภายนอกมหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร เมื่อมีการรองขอ 

 

1.5 คำจำกัดความเบ้ืองตน 

 โลโก หมายถึง ตราสัญลักษณของมหาวิทยาลัยหรือคณะตาง ๆ ในมหาวิทยาลัย 
 ภาพกราฟก หมายถึง รูปภาพทีแ่สดงขอมูลของกิจกรรมที่กำลังถายทอดสด 

Adobe Photoshop cc หมายถึง โปรแกรมผลิต ตกแตง แกไข ภาพกราฟกที่ใชในการถายทอดสด 

 คอมพิวเตอรกราฟก หมายถึง การสราง ตกแตง แกไข หรือจัดการภาพกราฟกดวยคอมพิวเตอร 

เครื่องสลับสัญญาณภาพและเสียง หมายถึง อุปกรณเลือกสัญญาณภาพและเสียง ใชสำหรับการ

ถายทอดสดผานอินเทอรเน็ต 
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บทที่ 2 

โครงสราง และหนาทีค่วามรับผิดชอบ 
 

 มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ไดสถาปนาขึ้นตามพระราชบัญญัติมหาวิทยาลัยเทคโนโลยีราช

มงคล เมื่อวันที่ 18 มกราคม พ.ศ. 2548 ประกอบดวยวิทยาเขต 5 แหงไดแก วิทยาเขตเทเวศร วิทยาเขตโชติเวช

วิทยาเขตพณิชยการพระนคร วิทยาเขตชุมพรเขตรอุดมศักด์ิ และวิทยาเขตพระนครเหนือ ขอมูลระบบเครือขาย 

คอมพิวเตอรเดิม แตละวิทยาเขตไดใชเทคโนโลยี ของ Cisco System โดยใช Router เปนอุปกรณคนหาเสนทาง 

เชื่อมตอผาน Leased Line มีBandwidth ขนาด 2 Mb ตอไปที่ สำนักเทคโนโลยีสารสนเทศ สถาบนัเทคโนโลยีราช

มงคล มหาวิทยาลัยเทคโนโลยรีาชมงคลพระนคร ไดดำเนินการจดโดเมนใหม เปน rmutp.ac.th ในวันที่ 8 กันยายน 

พ.ศ. 2548 เพื่อใหสอดคลองกับลักษณะขององคกร 

 ตอมาเมื่อวันที่ 14 พฤศจิกายน พ.ศ. 2549 ไดมีกฎกระทรวง จัดต้ังสวนราชการในมหาวิทยาลัยเทคโนโลยี

ราชมงคล ใหเปนสำนักวิทยบริการและเทคโนโลยีสารสนเทศ โดยมีสำนักงานชั่วคราวตั้งอยูที ่ อาคาร 1 ชั้น 4 

ปจจุบันต้ังอยู ณ อาคารอเนกประสงค มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร วิทยาเขตเทเวศร และมีศูนยวิทย

บริการและเทคโนโลยีสารสนเทศ อีก 4 แหง ไดแก สาขาโชติเวช สาขาพณิชยการพระนคร สาขาชุมพรเขตรอุดม

ศักด์ิและสาขาพระนครเหนือ 

 

วิสัยทัศน พันธกิจ เปาหมาย ยุทธศาสตร กลยุทธ ของสำนักวิทยบริการและเทคโนโลยีสารสนเทศ 

 วิสัยทัศน 

พัฒนาองคกรสูการเปนมหาวิทยาลัยดิจิตัล  

 ปณิธาน 

มุงมั่นเปนผูนำการจัดการศึกษาดานวิชาชีพดวยวิทยาศาสตรและเทคโนโลยีเชิงบูรณาการ  

พัฒนากำลังคนใหมีคุณภาพ คูคุณธรรม สูมาตรฐานสากล 

 พันธกิจ 
พัฒนานวัตกรรมดานไอซีที เพื่อสนับสนุนภารกิจหลักของมหาวิทยาลัยในการกาวไปสูการ 

เปนมหาวิทยาลัยดิจิตัล 

ผลิตการบริการ การศึกษาโดยใชนวัตกรรมดานไอซีที เพื่อบูรณาการเขากับการเรียนการ 

สอนสมยัใหม โดยผานระบบบริการอิเล็กทรอนิกส 

พัฒนาการบริหารจัดการองคกรโดยใชนวัตกรรมดานไอซีที เพื่อเพิ่มประสิทธิภาพและ 

ประสิทธิผลการบริหารการศึกษาสมัยใหมและเปนกลไกในการสรางหลักธรรมาภิบาล 

พัฒนาทรัพยากรบุคคลใหมีสมรรถนะทางไอซีทีที่มีคุณภาพ สอดคลองกับการพัฒนา 

ประเทศ 

จัดหาทรัพยากร ICT โดยใชเทคโนโลยีที่เหมาะสม สอดคลองกับภารกิจของมหาวิทยาลัย 
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 เปาประสงค 
ยกระดับเพิ่มขีดความสามารถของบุคลากรและนักศึกษาในการใชนวัตกรรมดิจิต ัลเพื่อ

การศึกษา 

พัฒนาสื่อและระบบสนับสนุนการเรียนรูในรูปแบบดิจิตัลเพื่อบูรณาการเขากับการเรียนการ 

สอนออนไลน 

สรางวัฒนธรรมการทำงานขององคกรใหเปนสังคมดิจิตัลที่มีคุณภาพ 

สรางระบบนิเวศดิจิตัลสำหรับงานวิจัยอยางครบวงจร เพื่อบูรณาการเขากับการบริหารจัดการ 

งานวิจัยและบริการงานวิชาการ 

สรางระบบบริหารจัดการเชิงกลยุทธ โดยใชเทคโนโลยีการประมวลผลขอมูลขนาดใหญ เพื่อเพิ่ม

ประสิทธิภาพและประสิทธิผลการบริหารจัดการและการพัฒนาองคกร 

พัฒนาโครงสรางพื้นฐานดานไอซีทีที่มีมาตรฐานและทันสมัยดวยเทคโนโลยีดิจิตัล 

  

กลยุทธ 
พัฒนาคุณภาพนักศึกษา (Smart Student)  

พัฒนาคุณภาพบุคลากรสายวิชาการ (Smart Lecturer) 

พัฒนาคุณภาพบุคลากรสายสนับสนุน (Smart Personal)  

พัฒนาคุณภาพระบบการจัดการความรู (Smart Knowledge) 

พัฒนาศูนยความเปนเลิศทางวิชาการ (Center of Excellence) 

พัฒนาคุณภาพหลักสูตรและการเรียนการสอน (Smart Learning)  

พัฒนาทรัพยากรการเรียนรูดิจิทัล (Smart Library) 

พัฒนาระบบงานการใหบริการอิเล็กทรอนิกส (e-Services)  

พัฒนาระบบบริหารและบริการงานวิจัย (e-Research)  

พัฒนาระบบบริหารจัดการเชิงกลยุทธ (e-Strategy)  

พัฒนาระบบประมวลผลขอมูลขนาดใหญ (Big Data) 

พัฒนาระบบการประกันคุณภาพการศึกษา (Quality Assurance) 

พัฒนาโครงสรางพื้นฐานทางดานเทคโนโลยีสารสนเทศและการสื่อสาร (e-Infrastructure) 
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2.1 โครงสรางการบริหารจดัการ 

 สำนักวิทยบริการและเทคโนโลยีสารสนเทศ มีโครงสรางของงาน  โครงสรางการบริหารหนวยงาน 

โครงสรางการปฏิบัติงานและภาระหนาที่ของหนวยงาน ดังน้ี 

 

 2.1.1 โครงสรางการบริหารจัดการองคกร 

 

1) โครงสรางหนวยงานของสำนักวิทยบริการและเทคโนโลยีสารสนเทศ (Organization 

chart) 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 2-1 แสดงโครงสรางหนวยงานของสำนักวิทยบริการและเทคโนโลยีสารสนเทศ 

 

 

 

 

 

 

กลุม 

เครือขายคอมพิวเตอร     

และการสื่อสาร 

งาน 

บริหารทั่วไป 

กลุม 

พัฒนานวัตกรรมและ

เทคโนโลยีการศึกษา 

กลุม 

วิทยบริการ 

กลุม 

เทคโนโลยีสารสนเทศ 

สำนักวิทยบริการและเทคโนโลยีสารสนเทศ 

สำนักงานผูอำนวยการ 
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2) โครงสรางการบริหารสำนักวิทยบริการและเทคโนโลยีสารสนเทศ (Administration 

chart) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 2-2 แสดงโครงสรางการบริหารสำนักวิทยบริการและเทคโนโลยีสารสนเทศ 

หัวหนากลุม 

เครือขายคอมพิวเตอร     

และการสื่อสาร 

หัวหนางาน 

บริหารทั่วไป 

หัวหนากลุม 

พัฒนานวัตกรรมและ

เทคโนโลยีการศึกษา 

หัวหนากลุม 

วิทยบริการ 
หัวหนากลุม 

เทคโนโลยีสารสนเทศ 

หัวหนาสำนักงานผูอำนวยการ 

รองผูอำนวยการ 

สำนักวิทยบริการและเทคโนโลยีสารสนเทศ 

หัวหนางาน 

วิทยบริการ 

หัวหนางาน 

หองสมุด 

หัวหนางาน 

วิจัยและพัฒนา

สื่อการศึกษา 

หัวหนางาน 

ผลิตสื่อโสตทัศน 

หัวหนางาน 

พัฒนาระบบเทคโนโลยี

สารสนเทศ 

หัวหนางาน 

ศูนยขอมูลสารสนเทศ 

หัวหนางาน 

พัฒนาระบบเครือขาย

คอมพิวเตอรและ 

การสื่อสาร 

หัวหนางาน 

บริการคอมพิวเตอร 

และระบบเครือขาย 

หัวหนางาน 

ศูนยการเรียนรูดวยตนเอง 

 

ผูอำนวยการ 

สำนักวิทยบริการและเทคโนโลยีสารสนเทศ 

รองผูอำนวยการ 

สำนักวิทยบริการและเทคโนโลยีสารสนเทศ 
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3) โครงสรางการปฏิบัติงานกลุมพัฒนานวัตกรรมและเทคโนโลยีการศึกษา สำนักวิทย

บริการและเทคโนโลยีสารสนเทศ (Activity chart) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

ภาพท่ี 2-3 แสดงโครงสรางการปฏิบัติงานกลุมพัฒนานวัตกรรมและเทคโนโลยีการศึกษา  

                           สำนักวิทยบริการและเทคโนโลยีสารสนเทศ 

นายธนาวุฒิ  นิลมณี 

ผูอำนวยการสำนักวิทยบริการและเทคโนโลยีสารสนเทศ 

หัวหนากลุมพัฒนานวัตกรรมและเทคโนโลยีการศึกษา 

นายนพชัย ทิพยไกรลาศ 

นักวิชาการโสตทัศนศึกษาชำนาญการพิเศษ 

หัวหนางานงานผลิตสื่อโสตทัศน 

นายกฤษณ จำนงนิตย 

นักวิชาการโสตทัศศึกษาปฎิบัติการ 

หัวหนางานงานวิจัยและพัฒนาสื่อการศึกษา 

นายปฐมพงศ จำนงคลาภ 

นักวิชาการโสตทัศนศึกษาชำนาญการ 

  นางสาวปญญาพร แสงสมพร   นักวิชาการโสตทัศนศึกษา 

  นายศักด์ิเทพ จำนงคลาภ      นักวิชาการโสตทัศนศึกษา 

นายกิตติ แยมวิชา  นักวิชาการโสตทัศนศึกษาปฏิบัติการ 

*น.ส.ดลวรรณ สุทธิวัฒนกำจร นักวิชาการชางศิลปปฏิบัติการ 

น.ส.มัณฑนา ตุลยนิษกะ นักวิชาการชางศิลปปฏิบัติการ 

นายอุเทน พรหมมิ  นักวิชาการโสตทัศนศึกษาปฏิบัติการ 

นางสาวจุติมา พูลสวัสด์ิ นักวิชาการชางศิลปปฏิบัติการ 

นายนรินทร จิตตม่ันการ นักวิชาการชางศิลปปฏิบัติการ 

นายกุลภัทร พลายพลอยรัตน ชางศิลป 

นายปยะนนท ศุภจริยวิชัย นักวิชาการโสตทัศนศึกษา 

นายพรรษชล นาคฉ่ำ  นักวิชาการคอมพิวเตอร 

นายครรชิต จิตตานุวัฒน  นักวิชาการคอมพิวเตอรปฏิบัติการ 
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2.1.2 ภาระหนาท่ีของสำนักวิทยบริการและเทคโนโลยีสารสนเทศ 

 สำนักวิทยบริการและเทคโนโลยีสารสนเทศ มีภารกิจมุงเนนพัฒนามหาวิทยาลัยเทคโนโลยีราชมงคล

พระนคร ใหเปนสังคมแหงการเรียนรู (Learning Society) โดยใช ICT เปนฐานในการบริการการศึกษาไดอยาง

เต็มศักยภาพ มีจริยธรรมและมีสมรรถนะทาง ICT ตามมาตรฐานสากล สำนักวิทยบริการและเทคโนโลยี

สารสนเทศ มีภาระหนาที่ แบงตามงาน 1 งาน และกลุม 4 กลุม ประกอบดวย สำนักงานผูอำนวยการ กลุม

เทคโนโลยีสารสนเทศ กลุมเครือขายคอมพิวเตอรและการสื่อสาร กลุมวิทยบริการ และกลุมพัฒนานวัตกรรม

และเทคโนโลยีการศึกษา 

2.1.2.1 สำนักงานผูอำนวยการ 

งานบริหารทั่วไป มีหนาที่รับผิดชอบหลัก ดังน้ี  

1) งานธุรการและสารบรรณ 

2) งานบัญชีการเงิน 

3) งานบุคลากร 

4) งานนโยบายและแผน 

5) งานพัสดุและอาคารสถานที่ 

6) งานฝกอบรม 

7) งานสถิติและประเมินผล 

8) งานประชาสัมพันธ 

9) งานประกันคุณภาพ 

2.1.2.2 กลุมเทคโนโลยีสารสนเทศ มีหนาที่รับผิดชอบหลัก ดังน้ี 

1) งานวางแผนและพัฒนาระบบสารสนเทศเพื่องานการบริหารจัดการภายใน 

                        มหาวิทยาลัยฯ 

2) งานดูแลเคร่ืองคอมพิวเตอรแมขาย (server)  

3) งานติดต้ังและพัฒนาระบบสารสนเทศเพื่อการบริหารงานภายในมหาวิทยาลัยฯ 

4) งานกำหนดมาตรฐานดานเทคโนโลยีสารสนเทศ 

5) งานดูแลระบบสารสนเทศเพื่อการบริหาร 

6) งานดูแลลิขสิทธิ์ซอฟตแวรในมหาวิทยาลัยฯ 

7) งานบริการระบบสารสนเทศเพื่อการจัดการ 

8) งานระบบประกันคุณภาพ 

9) งานพัฒนาศูนยปฏิบัติการเพื่อการตัดสินใจเชิงการตัดสินใจเชิงกลยุทธ 

10) ใหคำปรึกษาดานเทคโนโลยีสารสนเทศแกหนวยงานตาง ๆ ภายในมหาวิทยาลัย 

2.1.2.3 กลุมเครือขายคอมพิวเตอรและการสื่อสาร มีหนาที่รับผิดชอบหลัก ดังน้ี 

1) งานวางแผนและพัฒนาระบบเครือขายหลักของมหาวิทยาลัยและการเชื่อมโยง 
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                        เครือขายภายในมหาวิทยาลัย 

2) งานดูแลเครือขายคอมพิวเตอรหลัก 

3) งานดูแลเคร่ืองคอมพิวเตอรแมขายดานเครือขาย 

4) งานดูแลเว็บไซตของมหาวิทยาลัยดานเทคนิค  

5) งานใหบริการระบบเครือขายภายในมหาวิทยาลัย 

6) ใหคำปรึกษาการใชงานระบบเครือขายแกหนวยงานภายในมหาวิทยาลัย 

7) งานดูแลและใหบริการศูนยการเรียนรูดวยตนเองทั้ง 4 แหง ไดแก  

     ศูนยการเรียนรูดวยตนเองเทเวศร  

     ศูนยการเรียนรูดวยตนเองพระนครเหนือ   

     ศูนยการเรียนรูดวยตนเองพณิชยการพระนคร  

     ศูนยการเรียนรูดวยตนเองโชติเวช  

2.1.2.4 กลุมวิทยบริการ มีหนาที่รับผิดชอบหลัก ดังน้ี 

1) งานพัฒนาทรัพยากรสารสนเทศ 

2) งานวิเคราะหทรัพยากรสารสนเทศ 

3) งานวารสารและเอกสาร 

4) งานเตรียมทรัพยากรสารสนเทศ 

5) งานเทคโนโลยีสารนิเทศ 

6) งานใหบริการสารสนเทศและหองสมุด 4 แหง ไดแก 

     งานหองสมุดเทเวศร 

     งานหองสมุดโชติเวช 

     งานหองสมุดพณิชยการพระนคร 

     งานหองสมุดพระนครเหนือ 

2.1.2.5 กลุมพัฒนานวัตกรรมและเทคโนโลยีการศึกษา มีหนาที่รับผิดชอบหลัก ดังน้ี 

1) งานวิจัยและพัฒนาสื่อการศึกษา 

2) งานผลิตสื่อโสตทัศน 

3) งานผลิตสื่อคอมพิวเตอร 

4) งานบริการทรัพยากรสื่ออิเล็กทรอนิกส 
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2.2 บทบาทหนาที่ความรับผิดชอบ 

2.2.1 หนาท่ีความรับผิดชอบของตำแหนงตามมาตรฐานกำหนดตำแหนง 

ปฏิบัติงานในฐานนะผูปฏิบัติงานที่มีความเชี่ยวชาญในงานดานวิชาการชางศิลป โดยใชความรู 

ความสามารถ ความเชี่ยวชาญ และประสบการณสูง ปฏิบัติงานเชิงพัฒนาระบบหรือมาตรฐานของ

งานหรืองานพัฒนาทฤษฎี หลักการ ความรูใหม ปฏิบัติงานวิจัยดานวิชาการชางศิลป และนำมา

ประยุกตใชในทางปฏิบัติ เพื่อใหการดำเนินงานตามแผนงานโครงการสำเร็จตามเปาหมายและ

วัตถุประสงค ตลอดจนเสนอแนะและประเมินผลแผนงานโครงการและแกไขปญหาในงานที่มีความ

ยุงยากและมีขอบเขตกวางขวางมากหรือถายทอดความรูเกี่ยวกับงานตลอดจนใหคำปรึกษา แนะนำ 

หรือปรับปรุงผสมผสานเทคนิคระดับสูงระหวางสาขาที่เกี ่ยวของ และปฏิบัติหนาที่อื ่นตามที่ไดรับ

มอบหมาย หรือ 

ปฏิบัติงานในฐานะหัวหนาหนวยงาน มีหนาที่และความรับผิดชอบในการควบคุม กำกับ

หนวยงานดานวิชาการชางศิลปที ่มีขอบเขตเน้ือหาของงานหลากหลายและมีขั ้นตอนการทำงานที่

ยุงยากซับซอนมากเปนพิเศษ ตลอดจนกำกับ ตรวจสอบผูปฏิบัติงานเพื่อใหงานที่รับผิดชอบสำเร็จตาม

วัตถุประสงค และปฏิบัติหนาที่อ่ืนตามที่ไดรับมอบหมาย 

         โดยมีลักษณะงานที่ปฏิบัติในดานตาง ๆ ดังน้ี 

 1. ดานการปฏิบัติการ 

(1) ปฏิบัติหนาที่ในฐานะผูเชี ่ยวชาญดานวิชาการชางศิลป พัฒนาและประยุกตใชความรู 

ความสามารถ ความเชี่ยวชาญ ประสบการณ วิธีการและเทคนิคตาง ๆ เพื่อพัฒนาระบบและมาตรฐาน

ในการปฏิบัติงาน 

(2) เปนผูคิดริเริ ่มการดำเนินการวิจัยตาง ๆ  ในงานวิชาการชางศิลป และเผยแพรผลงานที่

กอใหเกิดความรูใหมหรือเทคนิควิธีการใหมที่เปนประโยชนตองานวิชาการชางศิลปวางหลักเกณฑใน

การวิเคราะห วิจัย ประเมินผล รวมทั้งกำหนดวิธีการและระเบียบปฏิบัติทางดานวิชาการชางศิลป เพื่อ

พัฒนาระบบหรือมาตรฐานในการปฏิบัติงานวิชาการชางศิลป เสนอความเห็นเกี่ยวกับปญหาและ    

หาวิธีการแกไขปญหาที่มีความยุงยากและมีขอบเขตกวางขวางมากทางดานวิชาการชางศิลป ติดตาม

ความกาวหนาทางวิชาการดานวิชาการชางศิลปและดานที่เกี่ยวของ เพื่อนำมาประยุกตใชใหเหมาะสม

กับลักษณะงานของหนวยงานและเปนที่ปรึกษาในโครงการวิจัยทางดานวิชาการชางศิลป เพื่อให

คำแนะนำและขอเสนอแนะในการดำเนินการ 

(3) ใหบริการวิชาการดานตาง ๆ  เชน ฝกอบรม ใหการบริการและเผยแพรความรูทางดาน

วิชาการชางศิลป ตอบปญหาและชี้แจงเร่ืองตาง ๆ เกี่ยวกับงานในหนาที่ เพื่อใหสามารถปฏิบัติงานได

อยางถูกตอง มีประสิทธิภาพ เขารวมประชุมคณะกรรมการตาง ๆ ตามที่ไดรับแตงต้ัง เปนผูแทนของ

สถาบันอุดมศึกษาหรือของรัฐบาลในการเขารวมประชุมหรือเจรจาปญหาตาง ๆ เกี่ยวกับงานวิชาการ
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ชางศิลปทั ้งในและตางประเทศ เพื่อใหขอมูลทางวิชาการประกอบการพิจารณาและตัดสินใจ และ

ปฏิบัติหนาที่อ่ืนที่เกี่ยวของ 

(4) ในฐานะหัวหนาหนวยงาน นอกจากอาจปฏิบัติงานตามขอ (1)-(3) ดังกลาวขางตนแลว 

ตองทำหนาที่กำหนดนโยบายการปฏิบัติงาน ติดตอประสานงาน วางแผน มอบหมาย สงเสริม กำกับ 

ควบคุม ดูแล และตรวจสอบ ใหคำปรึกษา แนะนำ ปรับปรุงแกไข ติดตามประเมินผล และแกไข

ปญหาขอขัดของในการปฏิบัติงานในหนวยงานที่รับผิดชอบ เพื่อใหการปฏิบัติงานบรรลุตามเปาหมาย

และผลสัมฤทธิ์ที่กำหนด 

2. ดานการวางแผน 

รวมกำหนดนโยบายและแผนงานหรือโครงการของหนวยงานที่สังกัด วางแผนหรือรวมวาง

แผนการทำงานโดยเชื่อมโยงหรือบูรณาการแผนงานโครงการในระดับกลยุทธของสถาบันอุดมศึกษา

มอบหมายงาน แกไขปญหาในการปฏิบัติงาน ติดตามและประเมินผล เพื่อใหบรรลุตามเปาหมายและ

ผลสัมฤทธิ์ที่กำหนด 

3. ดานการประสานงาน 

(1) ประสานการทำงานโครงการตาง ๆ กับบุคคล หนวยงาน หรือองคกรอ่ืน โดยมีบทบาทใน

การจูงใจ โนมนาว เพื่อใหเกิดความรวมมือและผลสัมฤทธิ์ตามที่กำหนด 

(2) ใหขอคิดเห็นและคำแนะนำแกหนวยงานในสถาบันอุดมศึกษา รวมทั้งที่ประชุมทั้งในและ

ตางประเทศ เพือ่เปนประโยชนและเกิดความรวมมือในการดำเนินงานรวมกัน 

4. ดานการบริการ 

 (1) ใหคำปรึกษา แนะนำ วินิจฉัย ชี้แจง และตอบปญหาที่สำคัญหรือยุงยากซับซอนมาก 

เพื่อสรางความรูความเขาใจเกี่ยวกับงานวิชาการชางศิลป ใหบุคคลหรือหนวยงานสามารถดำเนินงาน

ไดลุลวงเปนไปตามนโยบายและแผนงานที่กำหนดไว หรือเพื่อเปนขอมูลประกอบการตัดสินใจและ

สนับสนุนภารกิจของหนวยงาน 

 (2) เผยแพร ถายทอดความรู ดานวิชาการชางศิลป เพื่อใหบุคคลทั่วไปไดรับความรูความ

เขาใจที่ถูกตองและเปนประโยชน 

2.2.2 บทบาทหนาท่ีความรับผิดชอบตามท่ีไดรับมอบหมาย    

        บทบาทหนาที่ความรับผิดชอบของนางสาวดลวรรณ สุทธิวัฒนกำจร ตำแหนงนักวิชาการชาง

ศิลป ระดับปฏิบัติการ ตามที่ไดรับมอบหมาย มีดังน้ี 

1. ผลิตภาพกราฟกเร่ิมตนรายการ จบรายการ กราฟกแถบชื่ออาจารยผูสอน กราฟกแถบชื่อ

รายการ สำหรับงานสื่อการเรียนการสอนทางไกลผานดาวเทียม 
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2. ผลิตภาพกราฟกเร่ิมตนรายการ จบรายการ กราฟกแถบชื่ออาจารยผูสอน กราฟกแถบชื่อ

รายการ สำหรับงานสื่อการเรียนการสอน Mooc 

3. จัดทำสคริปตและสตอร่ีบอรดทำหรับงานผลิตสื่อการเรียนการสอน Mooc 

4. ผลิตภาพกราฟกเร่ิมตนรายการ จบรายการ กราฟกแถบชื่ออาจารยผูสอน กราฟกแถบชื่อ

รายการ สำหรับงานสื่อวิดีทัศน 

5. ผลิตภาพกราฟกสำหรับเว็บไซตการเรียนการสอนผานระบบ LMS 

6. ผลิตภาพกราฟกสำหรับการถายทอดสัญญาณภาพและเสียงออกอากาศผานทางระบบ

อินเทอรเน็ต 

7. ผลิตภาพกราฟกสำหรับสื่อสิ่งพิมพ 

8. ผลิตภาพกราฟกสำหรับการประชาสัมพันธกิจกรรมมหาวิทยาลัยผานทางสื่อส ั งคม

ออนไลน 

9. ผลิตภาพกราฟกปกหนา ปกหลังและกลองใสแผนดีวีด ีสำหรับสื ่อการเรียนการสอน

ทางไกลผานดาวเทียมและสื่อวิดีทัศน 

10. จัดทำฉากและอุปกรณประกอบฉาก สำหรับการถายทำการถวายพระพรเน่ืองในวันคลาย

วันเฉลิมพระชนมพรรษาฯ 

11. ตรวจสอบ ดูแล บำรุงรักษา ซอมแซมอุปกรณที่ใชในการผลิตสื่อและฉากและอุปกรณ

ประกอบฉาก 

12. บำรุงรักษาครุภัณฑในสวนที่รับผิดชอบ 

13. รวมกำหนดนโยบายและแผนงานของหนวยงาน 

14. รวมจัดทำแผนการปฏิบัติงานประจำป 

15. จัดทำการประกันคุณภาพการศึกษา 

16. ประสานกับหนวยงานตาง ๆ ที่เกี่ยวของ 

17. ปฏิบัติงานอ่ืน ๆ ตามที่ไดรับมอบหมาย 
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จากภาระหนาที่ที่ไดรับมอบหมายดังกลาวขางตน ผูเขียนมีความสนใจในกระบวนการผลิตภาพกราฟก

สำหรับการถายทอดสัญญาณภาพและเสียงออกอากาศผานทางระบบอินเทอรเน็ต จึงนำมาเขียนคูมือการ

ปฏิบัติงาน โดยมีแผนผังขั้นตอนการปฏิบัติงานดังน้ี 

 

 

  

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

  

 

 

 

 
 

 

 

 

  

 

 

 

ภาพท่ี 2-4 แสดงแผนผังขั้นตอนการปฏิบัติงานการผลิตภาพกราฟกสำหรับการถายทอดสัญญาณภาพและ      

               เสียงออกอากาศผานทางระบบอินเทอรเน็ต 

ไมถูกตอง 

 

ไมถูกตอง 

 

รวบรวมขอมูล 

 

ตรวจสอบขอมูล 

 

ผลิตภาพกราฟก 
 

ตรวจสอบความถูกตองของ

ภาพกราฟก 
 

เร่ิมตน 

นำภาพกราฟกไปใชในการถายทอดสด 
 

สิ้นสุด 

ถูกตอง 

 

ถูกตอง 
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บทที่ 3 

หลักเกณฑวิธีการปฏบิัติงาน 

ในการผลิตภาพกราฟกสิ่งแรกที่ตองคำนึงคือ ลักษณะของกิจกรรมและกลุมเปาหมายของผูชมที่จะ

เปนตัวกำหนดแนวทางของภาพกราฟก ไมวาจะเปนภาพพักหนาจอ กราฟกแถบชื่อตาง ๆ เน่ืองจากกิจกรรม

และกลุมเปาหมายที่แตกตางกัน ภาพที่ตองการนำเสนอจึงแตกตางกันออกไป  

 กิจกรรมที่เปนพิธีการ เชน กิจกรรมวันไหวครู กิจกรรมพิธีซอมรับปริญญา ตัวอักษรควรมีลักษณะที่

เรียบงาย รูปภาพลักษณะเปนทางการ ควรใชสีโทนออนหรือเขม ไมควรเปนสีที่มีลักษณะฉูดฉาด จะทำใหดูไม

สบายตาและไมเปนที่นาเชื่อถือ 

 กิจกรรมที่เปนกึ่งพิธีการ เชน กิจกรรมวันปฐมนิเทศ เนื่องจากกิจกรรมวันปฐมนิเทศในชวงเชา 

ผูบริหารมหาวิทยาลัยจะใหคำแนะนำแกนักศึกษา ไมวาจะเปนการลงทะเบียนเรียน การเขาเรียน การเขารวม

กิจกรรมของมหาวิทยาลัย เปนตน ในชวงบายเปนกิจกรรมสันทนาการของรุนพี่และรุนนอง เพราะฉะน้ัน

รูปแบบของภาพกราฟกจึงตองนำเสนอในรูปแบบกึ่งทางการ  โดยการใชตัวอักษรที่เรียบงาย สีไมฉูดฉาด 

รูปภาพที่นำเสนอจะเปนรูปภาพที่มีลักษณะไมเปนทางการ ทำใหดูสบายตาแตไมนาเบื่อ 

 กิจกรรมที่ไมเปนทางการ เชน กิจกรรมการประกวด Miss RMUTP Award สามารถใชตัวอักษรที่มี

ลูกเลน มีสไตล สีที่ใชควรจะมีสีสันที่สดใส ภาพที่ใชเปนภาพที่มีชีวิตชีวา เพื่อดึงดูดความสนใจของผูชม 

ในการปฏิบัติงานคูมือเรื ่อง การผลิตภาพกราฟกในการถายทอดสดผานระบบอินเทอรเน็ต โดยใช

โปรแกรม Adobe Photoshop cc น้ัน มีทฤษฏีที่เกี่ยวของดังน้ี 

  3.1    องคประกอบศิลป 

  3.2    หลักการออกแบบ 

3.3    คุณสมบัติที่ควรรูของโปรแกรม Adobe Photoshop cc 

3.4    สวนประกอบในหนาตางของในโปรแกรม Adobe photoshop cc 

3.5    คียลัดในการใชงานของโปรแกรม Adobe Photoshop cc 
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3.1    องคประกอบศิลป 

3.1.1   จุด  

จุด คือ ลักษณะกลม ๆ เล็ก ๆ ไมมคีวามกวาง ความยาว ความหนา ความลึก เปนองคประกอบ

ที่เล็กที่สุด ใหความรูสึกหยุดนิ่ง ไมเคลื่อนไหว เมื่อนำจุดมาวางเรียงกันจะเกิดเปนเสนหรือรูปราง 

รูปทรงตาง ๆ ได 

3.1.2 เสน  

เสน คือ จุดหลาย ๆ จุดเรียงตอกันใหเกิดความยาวไปในทิศทางใดทิศทางหนึ่ง เสนที่เปน

พื้นฐานจะมีอยูสองชนิด คือเสนตรงและเสนโคง เสน เปนองคประกอบพื ้นฐานที่สำคัญในการ

ออกแบบ สามารถแสดงใหเกิดความรูสึกไดตามลักษณะของเสน เชน  

เสนนอน ใหความรูสึกกวางขวาง สงบ น่ิง ราบเรียบ 

เสนต้ัง ใหความรูสึกมั่นคง แข็งแรง สงางาม 

เสนเฉียง ใหความรูสึกเคลื่อนไหว ไมมั่นคง 

เสนโคง ใหความรูสึกออนโยน นุมนวล 

เสนคลื่น ใหความรูสึกเคลื่อนไหว ราเริง ตอเน่ือง 

เสนซิกแซกหรือเสนฟนปลา ใหความรูสึกขัดแยง ต่ืนเตน 

เสนประ ใหความรูสึกไมตอเน่ือง ไมมั่นคง ไมแนนอน 

3.1.3 รูปรางและรูปทรง  

โดยปกติแลวรูปรางและรูปทรงจะมีลักษณะคลาย ๆ  กัน แตกตางกันที่มิติ คือ รูปรางจะมี

ลักษณะเปน 2 มิติ มีความกวางและความยาว สวนรูปทรงจะมีลักษณะเปน 3 มิติ มีความกวาง ความ

ยาวและความลึกเพิ่มเขามา โดยรูปรางและรูปทรงสามารถแบงออกไดเปน 3 ประเภท คือ 

รูปรางและรูปทรงธรรมชาติ คือ รูปรางหรือรูปทรงที่เลียนแบบมาจากธรรมชาติ 

อาจจะเหมือนหรือคลายกับของจริง เชน คน สัตว ใบไม กอนเมฆ ภูเขา เปนตน 

รูปรางและรูปทรงเรขาคณิต คือ รูปรางหรือรูปทรงที่สรางขึ้นโดยเคร่ืองมือเรขาคณิต 

เชน วงเวียน ไมบรรทัด ไมฉาก หรือไมไดสรางขึ้นโดยเคร่ืองมือเรขาคณิต แตมีลักษณะเปน

รูปเรขาคณิต เชน วงกลม วงรี สามเหลี่ยม สี่เหลี่ยม เปนตน มีลักษณะที่แนนอน ตายตัว 
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รูปรางและรูปทรงอิสระ คือ รูปรางหรือรูปทรงที่มีลักษณะที่ไมแนนอน เคลื่อนไหว

อิสระตามแตผูสรางสรรค มีลักษณะที่ตรงขามกับรูปทรงเรขาคณิต 

3.1.4 ท่ีวาง  

ที่วาง คือ บริเวณที่ไมมีองคประกอบใด ๆ อยูรอบบริเวณน้ัน หรือพื้นที่ที่ลอมรอบรูปรางกับ

รูปทรง หรือพื้นที่ระหวางรูปรางกับรูปทรง หรือพื้นที่ภายในรูปทรง เปนตน ที่วางสามารถสราง

ความรูสึกได เชน ถามีที่วางนอยเกินไป จะทำใหเกิดความรูสึกอึดอัด คับแคบ แนน แตถามีที่วางมาก

เกินไป จะทำใหเกิดความรูสึกโลง โปรง สบายตา เปนตน ชลูด น่ิมเสมอ (2553 : 92-93) แบงที่วาง

เปน 6 ประเภท คือ 

1) ที่วางจริงและที่วางลวงตา ที่วางจริง คือ ที่วางที่สามารถรับรูสัมผัสไดในทางกายภาพ 

เชน งานประติมากรรม งานสถาปตยกรรม เปนตน เปนที่วางทางกายภาพ สวนที่

วางลวงตา เปนพื้นที่วางที่เกิดจากการสรางสรรคความกวาง ความยาวและความลึก 

ใหเกิดภาพ 3 มิติ เปนที่วางที่เกิดจากความรูสึก ไมสามารถสัมผัสไดจริง เชน ภาพ

จิตรกรรม ภาพพิมพ เปนตน  

2) ที่วางแบบ 2 มิติ คือ พื้นที่วางที่มีแคความกวางกับความยาว เปนพื้นที่วางของพื้นผิว

ที่แบนราบ เชน พื้นที่วางบนกระดาษ ผนัง เปนตน 

3) ที่วางแบบ 3 มิติ คือ พื้นที่วางที่มีความกวาง ความยาวและความลึก เปนที่วางที่มี

ปริมาตร เชน ที่วางในหอง ที่วางของรูปทรง 3 มิติ หรือที่วางในงานจิตรกรรมที่ทำ

ใหเกิดภาพลวงตาเปน 3 มิติ เปนตน 

4) ที่วางที่เปนกลาง เปนพื้นที่ที ่วางเปลา ยังไมไดกำหนดขอบเขต รูปรางลงไป เชน 

พื้นที่วางของกระดาษ ผนัง เปนตน 

5) ที่วางบวกและที่วางลบ ที่วางบวก คือ พื้นที่ที่อยูภายในรูปราง รูปทรงที่สรางขึ้น ถือ

วาเปนที่วางที่มีพลัง มีความหมาย สวนที่วางลบจะตรงขามกับที่วางบวก คือพื้นที่ที่

อยูภายนอกรูปราง รูปทรงที่สรางขึ้น  

6) ที่วาง 2 นัย คือ พื้นที่วางที่ถูกกำหนดใหความสำคัญเทาเทียมกัน ไมสามารถกำหนด

ไดวาบริเวณไหนคือที่วางบวก บริเวณไหนคือที่วางลบ 

3.1.5 พ้ืนผิว  

พื้นผิว คือ ลักษณะของผิวที่ปรากฏอยูสวนนอกสุดของวัตถุ มีลักษณะที่แตกตางกันออกไป 

รับรูไดดวยการรับสัมผัสทางกายและทางสายตา พื้นผิวสามารถกอใหเกิดความรูสึกในลักษณะตาง ๆ 

ได เชน หยาบ ละเอียด เรียบ ดาน ขรุขระ เปนตน แบงเปน 2 ลักษณะ คือ  
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พื้นผิวที่รับรูไดดวยการสัมผัส เปนพื้นผิวจริง ๆ ของวัตถุน้ัน ๆ เชน พื้นผิวของกระดาษทราย 

เปลือกไม แกว กระเบื้อง เปนตน 

พื้นผิวที่รับรูไดดวยตา คือ เปนลักษณะผิวที่ทำเทียมขึ้นเปนการลวงตา เชน กระเบื้องที่เปน

ลายไม มีลักษณะขรุขระ แตพอสัมผัสกลับมีลักษณะที่เรียบเนียน เปนตน 

3.1.6 แสงและเงา  

แสงและเงา คือ ความแตกตางของน้ำหนักสีบนผิววัตถุ เกิดจากวัตถุไดรับแสงไมเทากัน สวน

ที่ไมโดนแสงจึงเกิดเปนเงาขึ้น ทำใหเห็นน้ำหนักของสีที่แตกตางกัน การใชแสงและเงาจะทำใหเกิดมิติ 

เชน มีความลึกตื้นของผลงาน เกิดระยะใกลไกล เปนตน แสงและเงาที่เกิดบนวัตถุ แบงไดเปน 6 

ระดับ คือ 

บริเวณที่สวางที่สุด คือ บริเวณที่ถูกแสงมากที่สุด จนเกิดการสะทอน ทำใหสีที่เห็นมี

น้ำหนักนอยกวาสีจริงของผิววัตถุ มักเกิดบนวัตถุที่มีผิวเรียบ 

บริเวณสวาง คือ บริเวณที่วัตถุไดรับแสงแตไมเกิดการสะทอน 

บริเวณเงา คือ บริเวณที่วัตุไดรับแสงเพียงเล็กนอย 

บริเวณเงามืด คือ เปนบริเวณที่แสงไมสามารถสองผานไดและไดรับผลกระทบจาก

แสงสะทอนนอยที่สุด จึงเปนบริเวณที่มืดที่สุด สีบริเวณน้ีจึงมีคาน้ำหนักเขมสุด 

บริเวณแสงสะทอน คือ เปนบริเวณที่ไมไดโดนแสงโดยตรง แตไดรับแสงสะทอนจาก

วัตถุอื ่นที่อยูใกล ๆ  กัน น้ำหนักสีบริเวณนี้จึงนอยกวาบริเวณเงามืดแตเขมกวาบริเวณแสง

สวาง 

บริเวณเงาตกทอด คือ เปนบริเวณที่เงาของวัตถุนั ้น ตกทอดไปยังวัตถุอื ่น มีคา

น้ำหนักสีออนเขมไมเทากัน บริเวณที่ใกลวัตถุจะมีน้ำหนักเขมมากกวาบริเวณอ่ืน  

3.1.7 สี   

สี เป นส วนประกอบของศิลปะที ่ม ีความสำคัญ และมีบทบาทที ่ค อนข างโดดเดนกวา

องคประกอบอ่ืน ๆ สามารถสรางความนาสนใจใหกับงานออกแบบ การใชสีอยางเหมาะสมจะชวยให

ผลงานในภาพรวมออกมามีความสวยงาม ชวยใหสารที่จะสื่อมีความเขาใจงายมากขึ้น นอกจากน้ีสียังมี

อิทธิพลตอจิตใจมนุษยเปนอยางมาก มีพลัง สามารถสรางปฏิกิริยากับอารมณ ความรูสึกของผูชมให

เปนไปตามที่นักออกแบบตองการ 
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1) คุณลักษณะของสี 

เน้ือสี (hue) คือ สีที่แสดงถึงความแตกตางวาเปนสีอะไร เชน สีแดง สีเหลือง สีน้ำเงิน เปนตน 

เปนสีแทที่อยูในธรรมชาติ ไมถูกผสมโดยสีใด ๆ แบงเปน 2 ประเภท คือ 

สีของแสง เกิดจากคลื่นความถี่ของแสงที่มนุษยสามารถมองเห็น เปนสีมีที ่มีอยูใน

แสงธรรมชาติ เชน สีของรุงกินน้ำ สีของทองฟาในชวงเวลาตาง ๆ เปนตน 

สีของสาร เปนสีที่มองเห็นบนวัตถุตาง ๆ ที่เกิดขึ้นโดยธรรมชาติ เชน สีดำของถาน สี

เหลืองของฟกทอง สีน้ำเงินของดอกอัญชัน สีของแรธาตุตาง ๆ เปนตน สีหรือเกิดจาก

กระบวนการทางเคมี เชน สีน้ำ สีโปสเตอร สีน้ำมัน เปนตน  

น้ำหนักสี (value) คือ คาความออนหรือความเขมของสี เร่ิมจากสวนที่ออนที่สุดจนเกือบขาว 

ไปจนถึงสีที่เขมที่สุดจนเกือบดำ สามารถเปลี่ยนแปลงไดโดยการเติมสีลงไป แบงออกเปน 3 ประเภท 

คือ  

Tint เปนการเติมสีขาวลงไปในสีแท ทำใหไดคาน้ำหนักสีที่ออนลง 

Tone เปนการเติมสีเทาลงไปในสีแท ทำใหไดคาน้ำหนักสีกลางหรือจาง 

Shade เปนการเติมสีดำลงไปในสีแท ทำใหไดคาน้ำหนักสีที่เขมขึ้น 

ความเขมของสี (intensity) คือ ความสดหรือความอ่ิมตัวของสี สีแทแตละสีจะมีคาความเขม

ของสีที่มากที่สุด เน่ืองจากยังไมไดถูกผสมกับสีใด ความสดของสีสามารถเปลี่ยนแปลงไดโดยการนำสี

แทมาผสมกับสีตาง ๆ เชน สีขาว สีดำ หรือสีคูตรงขาม ทำใหความสดของสีลดลง  

2) วงจรสี  

สีที ่นำมาใชในการสรางสรรคงานตาง ๆ  นั้น เปนสีที ่เกิดจากเนื้อสี เรียกวาสีวัตถุธาตุ ซึ่ง

สามารถแสดงความสัมพันธไดเปนวงสี (ฉัตรชัย อรรถปกษ, 2548 : 74) โดยวงสีจะแบงออกเปน 3 ขั้น 

คือ 

วงสีขั้นที่ 1 เรียกวาแมสี มี 3 สีพื้นฐาน คือ คือ สีแดง สีเหลือง สีน้ำเงิน เปนสีที่ไม

สามารถผสมขึ้นมาเองได 

วงสีขั้นที่ 2 เกิดจากการจับคูผสมกันของแมสีขั้นพื้นฐาน 2 สี ในอัตราสวนที่เทา ๆ 

กัน ทำใหเกิดสีใหม 3 สี  
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    แมสี    + แมสี    =      สีขั้นที่สอง 

         สีเหลือง    + สีน้ำเงิน    =      สีเขียว 

          สีเหลือง    + สีแดง    =      สีสม 

           สีแดง    + สีน้ำเงิน    =      สีมวง 

วงสีขั ้นที่ 3 เกิดจากการจับคูผสมกันของแมสีขั้นที่ 1 กับสีขั ้นที่ 2 ในอัตราสวนที่

เทากัน ทำใหเกิดสีใหมอีก 6 สี คือ สีเขียวน้ำเงิน สีเขียวเหลือง สีมวงน้ำเงิน สีมวงแดง สีสม

แดง สีสมเหลือง 

แมสี    + แมสี    =      สีขั้นที่สอง 

    สีน้ำเงิน    + สีเขียว    = สีน้ำเงินเขียว 

    สีน้ำเงิน    + สีมวง    = สีน้ำเงินมวง 

สีแดง    + สีสม    = สีแดงสม 

    สีแดง    + สีมวง    = สีแดงมวง 

    สีเหลือง    + สีสม    = สีเหลืองสม 

    สีเหลือง    + สีเขียว    = สีเหลืองเขียว 

หากนำแมสีทั ้งสามสีมาผสมกันในอัตราสวนที่เทากัน และสีที่นำมาผสมมีความ

เขมขนสูง จะเกิดเปนสีดำ ถาความเขมขนต่ำลงมาก็จะเปนสีเทา ในทางศิลปะเรียกสองสีน้ีวา 

สีกลาง 

จากแมสีสามสี สีขั้นที่สอง และสีขั้นที่สาม เมื่อรวมกันแลวจะไดสีทั้งหมด 12 ส ี

3) วรรณะสี 

วรรณะสี คือ กลุมสีที่ใหความรูสึกที่แตกตางกัน ถาแบงวงสีออกเปนสองซีก ซีกหน่ึงจะเปนสี

วรรณะรอน อีกซีกจะเปนสีวรรณะเย็น 

สีวรรณะรอน คือ สีที่ใหความรูสึกอบอุน รอนแรง ต่ืนเตน ราเริง มีสีแดงเปนหลัก สี

วรรณะรอนในวงสีมี 6 สี ประกอบไปดวย สีเหลือง สีเหลืองสม สีสม สีสมแดง สีแดง และสี

มวงแดง 
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สีวรรณะเย็น คือสีที่ใหความรูสึกอบอุน สบาย สงบ สดชื่น เรียบรอย มีสีน้ำเงินเปน

หลัก สีวรรณะเย็นในวงสีมี 6 สี ประกอบไปดวย สีมวง สีมวงน้ำเงิน สีน้ำเงิน สีน้ำเงินเขียว สี

เขียว และสีเขียวเหลือง 

สวนสีที่อยูไดทั้งวรรณะรอนและวรรณะเย็น คือสีมวงและสีเหลือง ถือเปนสีที่อยูใน

วรรณะกลาง ๆ ถาอยูในกลุมของสีรอนก็จะรอนไปดวย แตถาอยูในกลุมของสีเย็นก็จะเย็น 

4) สีกับความรูสึก 

   สีแดง ใหความรูสึกต่ืนเตน รุนแรง มีอำนาจ อันตราย 

   สีสม ใหความรูสึกอบอุน สดใส ราเริง คึกคะนอง ปลดปลอย 

   สีเหลือง ใหความรูสึกสดใส ราเริง เบิกบาน มีชีวิตชีวา 

   สีเขียว ใหความรูสึกผอนคลาย สงบ สันโดษ รมเย็น รมร่ืน ปลอดภัย 

   สีฟา ใหความรูสึกสงบ เยือกเย็น เปนอิสระ ปลอดภัย   

   สีน้ำเงิน ใหความรูสึกสุขุม หนักแนน สงางาม สูงศักด์ิ มีระเบียบ 

   สีมวง ใหความรูสึกมีเสนห ลึกลับ มีอำนาจ ความผิดหวัง  ความเศรา 

   สีชมพู ใหความรูสึกนารัก ใจกวาง อบอุน ออนเยาว ทะนุถนอม 

   สีน้ำตาล ใหความรูสึกมั่นคง เปนมิตร จริงใจ แข็งแรง แหงแลง ทรุดโทรม  

   สีเทา ใหความรูสึกมีระเบียบ สุภาพ สงบ เงียบ เศรา หดหู   

   สีดำ ใหความรูสึกพลังอำนาจ ลึกลับ นาเกรงขาม ความทุกข ลึกลับ  

   สีขาว ใหความรูสึกบริสุทธิ์ สันติภาพ เรียบงาย สะอาด วางเปลา  
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3.2    หลักการออกแบบ 

หลักการออกแบบคือ การนำองคประกอบศิลป มาจัดวางเพื่อใหเกิดความสวยงามและตรงตาม

วัตถุประสงคที่ตองการ มีหลักการดังน้ี 

3.2.1 ความสมดุล 

ความสมดุล คือ น้ำหนักที่เทากันของสิ่งตาง ๆ  เปนการกระจายน้ำหนักใหไมเอนเอียงไป

ทางดานในดานหน่ึง ความสมดุลในทางศิลปะน้ันเปนความสมดุลทางดานความรูสึก ซึ่งความสมดุลที่

เห็นอาจจะไมเทากัน แตสัมผัสไดดวยอารมณ ความรูสึกของคน แบงออกไดเปน 2 ประเภทคือ 

ความสมดุลแบบสองขางเทากัน หรือ ความสมดุลแบบสมมาตร คือ มีการจัดวางองคประกอบ

ตาง ๆ ที่เทากัน เหมือนกันทั้ง 2 ขาง ไมแตกตางกัน การจัดวางลักษณะน้ีใหความรูสึก มั่นคง สงางาม 

แข็งแรง นาเกรงขาม  

ความสมดุลแบบสองขางไม เท ากัน หรือความสมดุลแบบอสมมาตร คือการจัดวาง

องคประกอบที่ไมเหมือนกันทั้งสองดาน เชน มีขนาดและน้ำหนักไมเหมือนกัน สัดสวน ปริมาตรไม

เทากัน แตมองแลวใหความรูสึกที่เทากัน  

3.2.2 ความกลมกลืน 

ความกลมกลืน คือ การประสานกันขององคประกอบตาง ๆ เชน สี ขนาด รูปราง รูปทรง ที่

วาง ใหเปนอันหนึ่งอันเดียว ไมขัดแยงกัน เทียนชัย ตั้งพรประเสิรฐ (2549 : 57-58) แบงความ

กลมกลืนออกเปน 3 ลักษณะ คือ   

ความกลมกลืนจากสิ่งที่เหมือนกัน คือ ความกลมกลืนในการจัดองคประกอบดวยรูปรางหรือ

รูปทรงที่มีลักษณะซ้ำ ๆ กัน เชน ใชรูปทรงกลมเพียงอยางเดียว ทำใหดูนาเบื่อ ไมนาสนใจ 

ความกลมกลืนจากสิ่งที่คลายคลึงกัน คือ ความกลมกลืนจากการใชวัตถุ สิ่งของ ที่มีลักษณะ

ใกลเคียงมาจัดรวมกัน เชน การใชรูปวงกลมกับรูปวงรี จะไดผลนาสนใจขึ้น 

ความกลมกลืนจากสิ่งที่ตางกัน คือ ความกลมกลืนในการจัดองคประกอบดวยรูปรางรูปทรงที่

แตกตางกันหรือการขัดแยงดวยสี แตสามารถแสดงความกลมกลืนออกมาไดเปนอยางดี จะใหผลที่

นาสนใจ  

3.2.3 ความขัดแยง 

ความขัดแยง คือ ความแตกตางหรือความไมเขากันขององคประกอบตาง ๆ เชน สีตรงกันขาม 

รูปทรงที่แตกตางกัน ผิวหยาบกับผิวละเอียด เปนตน ความขัดแยงจะตรงกันขามกับความกลมกลืน 
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การใชความขัดแยงในงาน จะทำใหเกิดความนาสนใจมากยิ่งขึ้น ดูไมนาเบื่อ แตถามีความขัดแยงมาก

เกินไปจะทำใหขาดความสมดุล  ดังนั้นจึงตองใชความขัดแยงในปริมาณที่เหมาะสมจึงจะกอใหเกิด

ความสวยงาม 

3.2.4 การซ้ำ 

การซ้ำ คือ การนำองคประกอบที่มีลักษณะเหมือนกันมาใชมากกวา 1 คร้ังในการออกแบบ 

สามารถทำไดหลายวิธี เชน การซ้ำดวย เสน สี รูปราง รูปทรง น้ำหนัก ขนาด เปนตน หรือการซ้ำดวย 

ตำแหนง ทิศทาง ที่วาง เปนตน การซ้ำเปนการสรางสรรคงานที่งายที่สุด แตในขณะเดียวกันการซ้ำที่

เหมือนกัน อาจจะทำใหงานดูนาเบื่อ ไมมีความนาสนใจได 

3.2.5 จังหวะ 

จังหวะ คือ การซ้ำอยางเปนระเบียบ เปนการนำองคประกอบตางมาวางซ้ำ ๆ ตอเน่ืองกันไป 

โดยมีพื้นที่วางค่ันกลาง ซึ่งพื้นที่วางอาจจะเทากันหรือไมเทากันก็ได โดยพื้นที่วางจะเปนตัวกำหนด

ความถี่หางของจังหวะใหตอเนื่องกันหรือหยุดเปนชวง ๆ  จะทำใหเกิดความรูสึกตาง ๆ  ขึ ้นในงาน

ออกแบบ เชน เร็ว ชา ถี่ หาง เคลื่อนไหว หนักเบา เปนตน จังหวะแบงออกไดเปน 3 ประเภท คือ 

จังหวะซ้ำกัน คือ การนำองคประกอบที่เหมือนกัน ทั้งรูปราง รูปทรง น้ำหนัก สี เปน

ตน มาวางซ้ำกันต้ังแต 2 หนวยขึ้นไป โดยมีพื้นที่วางที่ค่ันกลางระหวางองคประกอบศิลปน้ัน 

จังหวะตอเน่ือง คือ การนำองคประกอบมาวางซ้ำ ๆ ใหเกิดการตอเน่ืองไปเร่ือย ๆ 

โดยไมมีพื้นที่วางมากั้นหรือกำหนดระยะ ทำใหเกิดความเคลื่อนไหวตอเน่ืองอยางสม่ำเสมอ  

ไมขาดระยะ เชน คลื่นในทะเล 

จังหวะกาวหนา คือ การนำองคประกอบมาจัดวางซ้ำ ๆ กัน โดยมีการเพิ่มขึ้นของ สี 

น้ำหนัก รูปราง รูปทรง พื้นผิว เปนตน ในองคประกอบน้ัน ๆ ทำใหในแตละระยะของการจัด

วางน้ันมีการเปลี่ยนแปลงไปเร่ือย ๆ  

3.2.6 การเนน 

การเนน คือ การทำใหบริเวณใดบริเวณหน่ึง มีความโดดเดน นาสนใจกวาองคประกอบอ่ืน ๆ 

เปนการบังคับสายตาใหมองมายังบริเวณที่ตองการ เพื่อกระตุนการรับรูของผูชม การเนนจะทำใหภาพ

มีเรื ่องราวที่นาสนใจมากขึ้น เทียนชัย ตั้งพรประเสริฐ (2549: 92-95) แบงการเนนออกเปน 4 

ลักษณะ ดังน้ี 

1) การเนนดวยการตัดกัน เปนการเนนที่ทำใหองคประกอบอ่ืน ๆ มีความขัดแยงกัน แบงได

เปนหลายลักษณะ คือ 
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การเนนดวยพื้นผิว เปนการใชลักษณะพื้นผิวที่แตกตางกัน เชน พื้นผิวหยาบกับ

พื้นผิวละเอียด เปนตน 

การเนนดวยขนาด เปนการเนนดวยรูปรางหรือรูปทรงที่มีขนาดไมเทากัน เชน 

วงกลมเล็ก และวงกลมใหญ เปนตน 

การเนนดวยสี เปนการใชสีที่ไมเหมือนกัน เชน สีออนกับสีเขม สีคูตรงขาม เปน

ตน 

การเนนดวยรูปทรง เปนการเนนดวยรูปทรงที่ไมเหมือนกัน เชน รูปทรงกลม

หน่ึงรูปกับรูปทรงสี่เหลี่ยมหลาย ๆ รูป หรือ รูปทรงเรขาคณิตกับรูปธรรมชาติ เปนตน 

การเนนดวยน้ำหนัก เปนการเนนดวยการใชน้ำหนักออนและน้ำหนักเขม เชน 

จุดสีขาวที่อยูบนพื้นสีดำ จุดสีขาวจะเดนขึ้น เปนตน 

2) การเนนโดยการแยกตัวออกไป เมื่อของสิ่งใดสิ่งหน่ึงถูกแยกออกมาจากกลุม ของสิ่งน้ัน

จะกลายเปนจุดเดนขึ้นมาทันที  

3) การเนนโดยการจัดวางตำแหนง เปนการใชองคประกอบนำสายตาใหมายังตำแหนงที่

ตองการเนนใหสนใจ แบงเปน 3 ลักษณะ คือ 

การจัดวางตำแหนงที่มีทิศทางคลอยตามกัน 

การจัดวางตำแหนงใหแพรเปนรัศมีจากจุดเดน 

การจัดวางตำแหนงโดยใชเสนนำสายตาไปยังสวนสำคัญของภาพ 

4) การไมปรากฏความเดนของจุดสนใจ คือ การไมเนนสิ่งใดสิ่งหน่ึงในภาพ ทุกสวนมีความ

โดดเดนเทาเทียมกันหมด เชน ลวดลายของเสื้อผา ลวดลายของเคร่ืองกระเบื้อง ลวดลาย

เคร่ืองประดับ เปนตน  

3.2.7 สัดสวน 

สัดสวน คือ ความสัมพันธกันอยางเหมาะสม ระหวางขนาดขององคประกอบตาง ๆ ที่มี

ลักษณะเหมือนกันและแตกตางกัน ใหความสัมพันธที่ไมมากไมนอยเกินไป มีความกลมกลืนกันของ

องคประกอบทั้งหลาย ประเสิรฐ พิชยะสุนทร (2555 : 128) แบงสัดสวนออกเปน 2 ลักษณะ ดังน้ี 

สัดสวนจากความรูสึก เปนสัดสวนที่สรางขึ้นเพื่อแสดงออกถึงอารมณความรูสึก ให

เปนไปตามที่ผูสรางผลงานตองการ อาจมีสัดสวนเหมือนจริงหรือบิดเบี้ยวผิดจากความเปน

จริงไปก็ได 
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สัดสวนที่เปนมาตรฐาน เปนสัดสวนจากลักษณะตามธรรมชาติของคน สัตว พืช เปน

ตน โดยทั่วไปถือวาสัดสวนตามธรรมชาติมีความงดงาม เหมาะสมที่สุด โดยสัดสวนที่ถือวามี

ความสวยงามที่สุด คือ สัดสวนทองคำ เปนการคำนวณหาสัดสวนที่สวยงามที่สุดในโลกโดย

วิธีการทางคณิตศาสตร คิดคนโดย ลีโอนาโด ฟโบนัชชี นักคณิตศาสตรชาวอิตาลี ยึดหลักที่วา 

สวนเล็กสัมพันธกับสวนที่ใหญกวา สวนที่ใหญกวาสัมพันธกับสวนรวม ทำใหทุกสิ่งที่สรางขึ้น

มีความสัมพันธกันอยางลงตัว มีอัตราสวนคือ 1:1.618 หรือ 2:3  

3.2.8 เอกภาพ 

เอกภาพ คือ ความเปนอันหน่ึงอันเดียวกัน หรือความเขากันได ที่เกิดจากการประสานกันของ

องคประกอบศิลป เชน จุด เสน รูปราง รูปทรง ลักษณะผิว สี เปนตน และนำองคประกอบศิลปเหลาน้ี

มาสรางสรรคใหงานมีความสมดุล ความขัดแยง ความกลมกลืน จนเกิดความเปนอันหน่ึงอันเดียวกัน 

สอดคลอง กลมกลืนกันทั้งงาน  

 

3.3    คุณสมบัติที่ควรรูของโปรแกรม Adobe Photoshop cc 

3.3.1 คุณสมบัติของเคร่ืองคอมพิวเตอรท่ีเหมาะกับ Adobe Photoshop cc 

Adobe Photoshop เปนโปรแกรมในตระกูล Adobe เหมาะสำหรับงานกราฟกทุกรูปแบบ 

เชน การตกแตงภาพ ออกแบบงานกราฟก สรางและแกไขรูปภาพ ใสเอฟเฟกตใหกับรูปภาพ หรือ

ตัวหนังสือ ทำภาพใหเปนขาวทำ ทำภาพถายใหเปนภาพเขียน เปนตน สามารถใชงานไดตั ้งแตมือ

อาชีพไปจนถึงมือสมัครเลน ไมวาจะเปนชางภาพ นักออกแบบกราฟก นักครีเอทีฟ นักออกแบบ

เว็บไซต หรือแมแตนักเรียน นักศึกษาที่ใชทำงาน ทำการบานสงอาจารย  

อนัน วาโซะ (2559 : 16) กำหนดคุณสมบัติเครื่องคอมพิวเตอรท ี ่ เหมาะกับการติดต้ัง

โปรแกรม Adobe Photoshop cc ดังน้ี  

  สำหรับ Windows จะตองมีคุณสมบัติ 

CPU: Intel Pentium 4 หรือ AMD 64 Processor (2GHz ขึ้นไป) 

ระบบปฏิบัติการ : Windows 7 Service Pack 1, Windows 8 หรือ 8.1 

หนวยความจำหลัก (RAM) : อยางต่ำ 1 GB 

พื้นที่วางบนฮารดดิส : อยางต่ำ 2.5 GB 

จอภาพ : ความละเอียดอยางต่ำ 1,028 x 768 Pixels หนวยความจำ 512 MB 

การดจอ : สนับสนุน OpenGL 2.0 16 bit 
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สำหรับ Mac OS จะตองมีคุณสมบัติ 

CPU: Multicore Intel Processor ที่สนับสนุน 16 bit 

ระบบปฏิบัติการ : Mac OS X v10.7 หรือ 10.8 หรือ 10.9 

หนวยความจำหลัก (RAM) : อยางต่ำ 1 GB 

พื้นที่วางบนฮารดดิส : อยางต่ำ 3.2 GB 

จอภาพ : ความละเอียดอยางต่ำ 1,028 x 768 Pixels หนวยความจำ 512 MB 

การดจอ : สนับสนุน OpenGL 2.0 16 bit 

3.3.2    ประเภทของภาพในงานคอมพิวเตอรกราฟก 

1) ความหมายของพิกเซล 

ภาพในคอมพิวเตอรเปนภาพแบบดิจิตัล เกิดจากจุดสี่เหลี่ยมเล็ก ๆ จำนวนมากเรียงตอ

กันจนทำใหเกิดภาพ จุดเล็ก ๆ น้ี เรียกกันวา พิกเซล (Pixel)  

 

 

 

 

 

 

พิกเซลเปนหนวยพื้นฐานของภาพ แตละพิกเซลจะมีคาสีเปนของตัวเองไมซ้ำกัน ภาพแตละ

ภาพจะมีความหนาแนนของพิกเซลที่แตกตางกัน ความหนาแนนน้ีเปนตัวบงบอกถึงความละเอียดของ

ภาพ มีหนวยเปน ppi (Pixel Per Inch) คือ จำนวนพิกเซลตอตารางน้ิว เชน ภาพที่มีความละเอียด 

300 ppi หมายถึง ใน 1 ตารางน้ิวของภาพ จะมีจำนวนจุดพิกเซลอยู 300 จุด ดังน้ันความคมชัดของ

ภาพขึ้นอยูกับจำนวนของพิกเซล ยิ่งมีจำนวนพิกเซลมากความละเอียดของภาพยิ่งสูง วิธีการคำนวณ

จำนวนพิกเซลในภาพ คือ  

จำนวนพิกเซลของภาพ = (ความกวาง x ความละเอียด) x (ความสูง x ความละเอียด) 

เชน มภีาพขนาดกวาง 6 น้ิวและสูง 4 น้ิว มีความละเอียดที่ 72 =pixels/inch มีจุดสีทั้งหมด

เทากับ (6 x 72) x (4 x 72) = 432 x 288 หรือ 124,416 pixels (ดวงพร เกี๋ยงคำ, 2553:117) 

ภาพท่ี 3-1 ลักษณะพิกเซลของภาพ 
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2) ประเภทของภาพในงานคอมพิวเตอรกราฟก  

โดยปกติคอมพิวเตอรมีการประมวลผลภาพอยู 2 รูปแบบ คือ ภาพแบบ Bitmap 

หรือ Raster  และภาพแบบ Vector  

ภาพแบบ Bitmap หรือเรียกอีกแบบวา Raster เปนภาพที่เกิดจากการเรียงตัวกัน

ของพิกเซลจนกลายเปนภาพ แตภาพมีจำนวนพิกเซลตายตัวตามการสรางภาพที่มีความ

ละเอียดแตกตางกัน ดังน้ันเมื่อมีการขยายภาพ ความละเอียดของภาพลดลง ทำใหสามารถ

มองเห็นพิกเซลเรียงตัวอยางชัดเจน ภาพ Bitmap มีขอดีคือ เหมาะสำหรับภาพที่มีการแสดง

เฉดสีและสีสันจำนวนมาก ไลคาน้ำหนักสีไดเปนธรรมชาติ สรางสี ระบายสี หรือกำหนดสี

อยางละเอียดสวยงามไดงาย ดังนั้น ภาพแบบ Bitmap จึงเหมาะกับงานดานภาพถายและ

งานระบายสี ไฟลของรูปภาพประเภทนี้คือ ภาพที่มีนามสกุลเปน .BMP, .PCX, .TIF, .GIF, 

.JPG, .MSP, .PCD, .PCT เปนตน (พงษศักด์ิ ไชยทิพย, 2549:102) และโปรแกรมที่ใชจัดการ

ภาพประเภทน้ีคือ โปรแกรม Paintbrush, Photoshop, PhotoScape, Lightroom เปนตน 

(6 x 72=432 pixels) 

6 น้ิว 

4 น้ิว 
(4 x 72=288 pixels) 

ภาพท่ี 3-2 ตัวอยางภาพถายขนาด 4x6 น้ิว ความละเอียด 72 pixels/inch มีจำนวน 

              พิกเซลทั้งหมด 124,416 pixels 
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ภาพแบบ Vector คือ ภาพที่สรางขึ้นดวยการนำจุดและเสนมาสรางเปนรูปราง 

รูปทรงจนกลายเปนภาพโดยใชหลักการ Vector ทางคณิตศาสตร สามารถลากเสนไปในแนว

ตาง ๆ ไดไมมีที ่สิ้นสุด ขอดีของภาพ Vector คือ สามารถขยายไปไดไมจำกัด โดยที่ไมลด

คุณภาพ เหมาะกับงานการตูนหรืองานกราฟกที่ตองการความคมชัดสูง เชน งานปายโฆษณา

หรือโปสเตอรที่มีขนาดใหญ แตขอเสียคือจะทำใหไฟลมีขนาดใหญตามไปดวย ภาพ Vector 

สามารถเปลี่ยนเปนภาพ Bitmap ได โดยที่ความละเอียดของภาพทีแ่ปลงออกมาจะขึ้นอยูกับ

การกำหนดคาความละเอียดและรูปแบบของไฟล  แตเมื่อเปลี่ยนเปนภาพ Bitmap แลว จะ

ไมสามารถแกไขหรือจัดการภาพโดยไมสูญเสียความละเอียดไดเหมือนเดิม โปรแกรมที่ใช

จ ั ดการภาพประ เภทน ี ้ ค ื อ  โปรแกรม  Illustrator, CorelDraw, AutoCAD เป  นต น             

สวนนามสกุลของไฟลประเภทน้ี คือ .ESP, .AI, .CDR, .DEW, .CGM เปนตน  

โดยทั่วไปภาพที่มีความละเอียดสูงหรือคุณภาพดี ควรจะมีคาความละเอียด 300 ppi 

ขึ้นไป คา ppi ยิ่งสูง ภาพก็จะมีความละเอียดคมชัดมากยิ่งขึ้น และเพื่อใหไดผลงานที่มีภาพ

ความคมชัด ไมแตกเบลอ นักออกแบบจะตองรูจักกำหนดคาความละเอียดของภาพให

เหมาะสมกับรูปแบบของงาน ดังน้ี 

คาความละเอียด 72 ppi สำหรับงานแสดงผลบนจอคอมพิวเตอร เชน งานออกแบบ

เว็บไซต แบนเนอรตาง ๆ เปนตน  

   คาความละเอียด 150 ppi สำหรับหรับภาพที่พิมพผานปรินเตอร  

 คาความละเอียด 300 ppi สำหรับงานสิ่งพิมพ เชน โปสเตอร ปกหนังสือ แผนพับ 

เปนตน   

ภาพท่ี 3-3 การขยายภาพแบบ Bitmap จนเห็นพิกเซลเรียงตัวกันเปนตาราง 
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หากนำภาพมาใชผิดประเภท เชน นำภาพแบนเนอรจากเว็บไซตที ่มีความละเอียด 

72 ppi มาใชพิมพในแผนพับที่จะตองใชภาพที่มีความละเอียดอยางต่ำคือ 300 ppi จะทำให

ภาพในแผนพับที่พิมพออกมาน้ันไมคมชัดหรือที่เรียกกันวา ภาพแตกน่ันเอง 

 

 

 

 

 

ภาพท่ี 3-4 เปรียบเทียบความละเอียดของภาพระหวาง 72 ppi (ซาย) และ 300 ppi (ขวา) 

 

3.3.3    รูปแบบของไฟลกราฟกแบบตาง ๆ 

BMP (Bitmap) เปนไฟลมาตรฐานของวินโดว ประกอบไปดวยจุดเล็ก ๆ เรียงกันจนเปนภาพ

ตามความละเอียดของภาพ ภาพที่มีความละเอียดสูงจะมีขนาดใหญใชงานไมสะดวก ภาพที่มีความ

ละเอียดนอย เมื่อขยายใหใหญความละเอียดของภาพจะลดลง เหมาะสำหรับงานภาพเหมือนจริง  

JPEG (Joint Photographic Experts Group) เปนไฟลที่สรางขึ้นมาเพื่อบีบอัดขอมูลภาพ 

แสดงผลได 16 ลานสี เหมาะกับงานภาพถาย ภาพสแกนและเว็บไซต สามารถต้ังคาการบีบอัดได แต

จะสูญเสียรายละเอียดในการแสดงผลทุกคร้ังที่มีบีบอัดไฟลภาพ  

GIF (Graphic Interchange File) เปนไฟลที่มีการบีบอัดขอมูลสูง ทำใหภาพมีขนาดเล็ก 

แสดงสีไดเพียง 256 สี เหมาะกับงานที่มีจำนวนสีไมเยอะและไมมีการไลคาน้ำหนักสีมาก สามารถทำ

เปนไฟลแอนิเมชันได นิยมนำมาใชงานในระบบอินเทอรเน็ตเน่ืองจากสามารถดาวโหลดไดรวดเร็ว   

PNG (Portable Network Graphics) เปนไฟลภาพที่รวมคุณสมบัติที่ดีของไฟล JPEG และ 

GIF เขาไวดวยกัน มีการบีบอัดไฟลใหมีขนาดเล็กและดีกวาไฟล GIF ทำใหไดไฟลที ่มีขนาดเล็กแต

สูญเสียรายละเอียดในการแสดงผลนอยและยังสามารถเลือกเซฟไฟลการแสดงผลของสีระหวาง 256 

สี และ 16 ลานสี แตไมสามารถทำไฟลแอนิเมชันได  

TIFF (Tagged Image File Format) เปนไฟลที่ไมมีการบีบอัดขอมูล แสดงผลของสีไดทุก 

ระดับตั้งแตสีขาวดำไปจนถึงภาพสีความละเอียดสูง หากมีการแกไขภาพจากโปรแกรมตาง ๆ  ไฟล 
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TIFF ยังสามารถเก็บเลเยอรไวได สงผลใหมีขนาดไฟลคอนขางใหญ นิยมใชกันในงานกราฟก สื่อ 

สิ่งพิมพ 

RAW file เปนไฟลรูปภาพที่เกิดจากการบันทึกของกลองถายรูป DSLR เซ็นเซอรของกลอง

เห็นภาพอยางไรก็สงขอมูลมาเปนไฟล RAW อยางน้ัน เปนไฟลที่ยังไมผานการปรับแตง ไมถูกบีบอัด 

เพิ่มความคมชัด หรือเรงสี มีประสิทธิภาพสูงในการนำมาตกแตงแกไขภาพในภายหลัง ขอเสียของไฟล 

RAW คือ มีขนาดใหญมากทำใหกินพื้นที่ในการจัดเก็บและตองใชโปรแกรมเฉพาะในการเปดไฟลภาพ

ไมวาจะเปนการเปดดูหรือเปดเพื่อแกไขภาพ เชน เชน โปรแกรม Photoshop, Lightroom, Camera 

Raw เปนตน  

PSD (Photoshop Document) เปนไฟลที่ใชสำหรับโปรแกรม Photoshop โดยเฉพาะ 

สามารถบันทึกแบบแยกเลเยอรและประวัติการทำงานตาง ๆ ทำใหไฟลมีขนาดคอนขางใหญ นอกจาก

การเปดดวยโปรแกรม Adobe Photoshop แลว ยังสามารถใชโปรแกรมอื่นเปดดูไฟลภาพหรือทำ

การแกไขไดดวย เชน โปรแกรม ACDsee, Adobe ImageReady, Adobe Illustrator เปนตน  

 3.3.4    สีในงานคอมพิวเตอรกราฟก 

1)   ความเขมของสี โดยสวนใหญสายตาของมนุษยสามารถแยกสีออกไดเปน 3 ลักษณะ คือ 

Hue Saturation และ Brightness 

Hue คือ สีตาง ๆ ของวัตถุ โดยแตละสีจะแตกตางกันตามความยาวของคลื่นแสงที่

กระทบวัตถุแลวสะทอนกลับมายังสายตาของเรา Hue จะแทนคาสีดวยองศา จาก 0 ถึง 360 

องศา  

 

 

 

 

Saturation คือ ความสดของสี วัดเปนเปอรเซ็นตจากปริมาณสีเทาที่มีอยูในสีน้ัน 

0% แสดงวามีสีเทามากที่สุด ความสดของสีเปน 0 100% แสดงวามีสีเทามากที่สุด มีความ

สดของสีสูงที่สุด  

 

 

ภาพท่ี 3-5 Hue ที่แทนคาสีดวยองศา  

0 O 180 O 360 O 
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Brightness คือ ความสวางและความมืดของสี มีความสัมพันธกับแสงและเงา การ

วัดคาความสวางจะคำนวณจากปริมาณสีดำที่ผสมอยู โดยมีการกำหนดคาเปนเปอรเซ็นต 

จาก 0% คือ สีดำ มืดที่สุด จนถึง 100% คือ สีขาว สวางมากที่สุด 

 

 

 

 

2)   การผสมสี (Color Mixing) คือการนำแมสี 3 สีมาผสมเขาดวยกัน แบงไดเปน 2 รูปแบบ 

คือ  

การผสมสีแบบบวก (additive color mixing) เปนการผสมกันของสีของแสง มีแมสี

หลักอยู 3 สี คือ สีแดง (Red) สีเขียว (Green) และสีน้ำเงิน (Blue) เรียกวาระบบสี RGB เมื่อ

ฉายแมสีแสงสามสีนี ้ลงบนฉากสีขาว คลื่นแสงเกิดการซอนทับกันทำใหเกิดการบวกและ

รวมตัวกันของความยาวคลื่นแสง จะทำใหเกิดสีตาง ๆ ขึ้น แมสีหลักทั้ง 3 สีน้ี เรียกวาสีขั้นที่ 

1 เมื่อนำแมสีสองสีมาผสมในอัตราสวนที่เทากันก็จะไดสีขั้นที่ 2 ดังน้ี  

    สีน้ำเงิน +   สีเขียว     = สีน้ำเงินแกมเขียว (cyan) 

       สีแดง +   สีน้ำเงิน     =       สีแดงแกมมวง (magenta) 

    สีแดง +   สีเขียว    = สีเหลือง (Yellow) 

เมื่อนำแมสีทั้ง 3 สีมาผสมเขาดวยกันจะไดเปนแสงสีขาว แตถาไมมีสีใด ๆ เลย จะไดเปนสีดำ 

 

 

 

ภาพท่ี 3-6 แสดงความสดของสี 

0% 100% 

0% 100% 

ภาพท่ี 3-7 แสดงความสวางและความมืดของสี 
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การผสมสีแบบลบ (Subtractive Color Mixing) คือ การที่แสงสีขาวสองมากระทบ

โดนวัตถุ วัตถุน้ันจะดูดกลืนความยาวคลื่นแสงบางระดับไว ทำใหปริมาณแสงสะทอนออกมา

ลดลง จึงเปนที่มาของการผสมสีแบบลบ ดังน้ันแมสีหลักทั้ง 3 สี ประกอบไปดวยสีชมพูมวง 

(magenta) สีฟา (cyan) และสีเหลือง (Yellow) เปนสีขั้นที่ 1 และเมื่อนำแมสีสองสีมาผสม

ในอัตราสวนที่เทากันก็จะไดสีขั้นที่ 2 ดังน้ี 

สีฟา   +   สีเหลือง = สีเขียว  

สีชมพูมวง +   สีฟา  =       สีมวง 

สีชมพูมวง +   สีเหลือง = สีสม  

และเมื่อนำแมสีทั้ง 3 สีมาผสมเขาดวยกัน จะไดเปน แสงสีดำ แตถาไมมีสีใด ๆ เลย 

จะไดเปนสีขาว 

 

 

 

 

 

 

 

ภาพท่ี 3-8 การผสมสีแบบบวก (additive color mixing) 

ภาพท่ี 3-9 การผสมสีแบบลบ (Subtractive Color Mixing) 
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3)   โหมดสี (Color Mode) ระบบสีของไฟลภาพ ซึ่งแตละโหมดสีจะแตกตางกันออกไปตาม

การใชงาน สำหรับ Photoshop มีโหมดสีดวยกันทั้งหมด 8 โหมด คือ 

Bitmap เปนโหมดภาพขาว-ดำที่แสดงสีไดเพียง 2 สี คือสีขาวและสีดำเทาน้ัน ไมมี

การไลน้ำหนักออนแก ทำใหภาพที่ไดมีความละเอียดนอยที่สุด เหมาะสำหรับภาพลายเสน 

Grayscale เปนโหมดภาพขาว-ดำ ที่มีการแสดงสี 3 สีคือ ขาว ดำ เทา สามารถไล

น้ำหนักไดถึง 256 ระดับ  

Duotone เปนภาพแบบ 2 โทนสีที่พัฒนามาจากภาพ Grayscale สามารถกำหนดสี

ใหเขามาไลน้ำหนักไดแทนสีขาวและสีดำ สรางไดทั ้งภาพสีเดียว (Monotone) ภาพ 2 สี 

(duotone) ภาพ 3 สี (Tritone) และภาพ 4 สี (Quadtone)  

Indexed Color เปนภาพที่จำกัดจำนวนสีที่แสดงใหสูงสุดเพียงแค 256 สี เทาน้ัน 

ทำใหขนาดของภาพไมใหญมากนักและมีคุณภาพต่ำ  

RGB Color เปนโหมดที่ใช channels แสดงสีจำนวน 3 สี ตามแมสีของแสง คือ สี

แดง สีเขียวและสีน้ำเงิน ในแตละสีจะแสดงคาสีได 256 สี เมื่อรวมกันทั้ง 3 สีจะแสดงคาสีได

สูงสุดถึง 16.7 ลานสี เหมาะสำหรับใชตกแตงเพราะสามารถแสดงคาสีไดมาก 

CMYK เปนโหมดที่ใช channels ในการแสดงสีจำนวน 4 สี คือ สีฟา (Cyan) สีชมพู

มวง (Magenta) สีเหลือง (Yellow) และสีดำ (Black) เปนโหมดสำหรับการพิมพเพื่อใหได

ภาพที่ใกลเคียงกับภาพถายมากที่สุด 

Lab Color เปนโหมดสีที่แยก channels แมสีและคาแสงออกจากกัน โดยใชคา 

Lightness แทนความสวาง คา a แทนสีเขียวถึงแดง คา b แทนสีน้ำเงินถึงเหลือง เปนโหมด

ที่ใหสีไดเหมือนจริงที่สุด เหมาะกับงานแตงภาพถาย 

Multichannel เปนโหมดสีที่มีระบบแบบ CMYK แตไมมี channels สีดำ (K-Black) 

มีสีไดสูงสุดเพียง 256 สี เหมาะกับการพิมพที่ตองการผลลัพธพิเศษในการพิมพ 
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3.3 สวนประกอบในหนาตางของโปรแกรม Adobe photoshop cc 

 

 

 

     

 

 

 

 

1. Menu Bar เปนแถบรวบรวมชุดคำสั่งทั้งหมดของโปรแกรม แยกเปนหมวดหมูตามรูปแบบการใช

งานดังตารางตอไปน้ี  

ตารางท่ี 3-1 ตารางรูปแบบการทำงานชุดคำสั่งของโปรแกรม Adobe Photoshop cc 

เมนู รูปแบบการทำงาน  

File จัดการกับไฟลภาพในการสรางไฟลใหม เปด ปดไฟลในรูปแบบตาง ๆ บันทึก Import  

Export และอ่ืน ๆ ที่เกี่ยวกับไฟลภาพไฟล  

Edit ใชสำหรับการแกไข ปรับแตงภาพ เชน ตัด คัดลอก วาง เติมสี รวมถึงปรับแตงคา 

เบื้องตนของโปรแกรม เชน คาสี คำสั่งลัดของโปรแกรม ปรับแตง Toolbar เปนตน  

Image สำหรับการปรับแตงภาพที่แสดงผลทั้งภาพ เชน แกไขความสวาง ปรับโหมดสี ปรับ

ขนาดของภาพ เปนตน  

Layer จัดการเลเยอรของไฟลภาพ เชน สรางเลเยอรใหม รวมเลเยอร แปลงเลเยอร การ 

จัดการเลเยอร เปนตน 

Type จัดการขอความตาง ๆ เชน แกไขขอความ แกไขรูปแบบของตัวอักษร ปรับแตงสี 

ตัวอักษร เปนตน 

Select จัดการ Selection  โดยสามารถปรับแตง บันทึกและเรียก Selection มาใชงานได  

เปนตน 

ภาพท่ี 3-10 สวนประกอบของโปรแกรม Adobe photoshop cc 

Option bar 2 

Toolbox 

3 4 
Panel 

Menu 
Workspace 

5 

Artboard 

6 

Menu Bar 1 
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เมนู รูปแบบการทำงาน  

Filter ปรับแตงภาพโดยอัตโนมัติ เชน ทำภาพเบลอ ทำภาพใหเกิด Noise หรือทำภาพลาย

น้ำ เปนตน   

3D จัดการไฟลสามมิติ เชน สรางภาพสามมิติ สรางรูปทรงสามมิติ จัดการไฟลสามมิติ  

เปนตน  

 View กำหนดมุมมองของภาพในรูปแบบตาง ๆ เชน การยอขยาย การแสดง Grid Guide ไม 

บรรทัด  

 Window ใชสำหรับการกำหนดรูปแบบพื้นที่การทำงานและใชสำหรับเปด-ปดพาเนลตาง ๆ 

 Help รวบรวมวิธีการและคำแนะนำในการใชงาน Adobe Photoshop 
 

 

 

 

 

 การเรียกใช Menu Bar สามารถใชเมาสคลิกเรียกใชคำสั่งในแถบ Menu Bar ได หากคำสั่งไหนมีรูป

ลูกศร    แสดงวามีคำสั่งยอยอยูในคำสั่งหลักอีกที เลือกคำสั่งยอยโดยการเลื่อนเมาสไปตรงคำสั่งหลัก จะมี

หนาตางของคำสั่งยอยปรากฏขึ้นมา แลวเลื่อนเมาสไปเลือกคำสั่งยอยที่ตองการได 

 

 

 

 

 

 

 

 

ภาพท่ี 3-11 แถบคำสั่ง Menu Bar 

 

ภาพท่ี 3-12 การเลือกใชคำสั่งยอยใน Menu Bar 
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 การเรียกใช Menu Bar สามารถทำไดอีกวิธีหน่ึงนอกเหนือจากการใชเมาสคลิกเลือกคำสั่ง คือการใช 

คียลัดเรียกคำสั่ง 

 

 

 

 

 

 

 

2. Option bar เปนแถบที่ใชปรับแตงคาตาง ๆ ของเคร่ืองมือ เชน เมื่อเลือกเคร่ืองมือพูกัน Option 

bar จะแสดงขนาดหัวพูกัน ความคมชัดในการใชพูกัน หรือเมื่อเลือก Type Tool  Option bar 

จะแสดงชื่อฟอนท ขนาดของฟอนท ความหนาบางของฟอนท เปนตน 

 

 

 

 

หากมีการเรียกใชเคร่ืองมือบอย ๆ สามารถบันทึกคาการทำงานของเคร่ืองมือได ดังน้ี 

1. เลือกเคร่ืองมือที่ตองการบันทึก 

2. กำหนดคาเคร่ืองมือตามที่ตองการ 

3. คลิกปุมสามเหลี่ยม 

4. คลิกปุมสี่เหลี่ยมพับมุม  

5. ต้ังชื่อ 

6. คลิก Ok  

ภาพท่ี 3-14 Option Bar ของ Type Tool 

ภาพท่ี 3-13 คียลัดที่ใชเรียกคำสั่งของ Menu Bar 
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3. Toolbox เปนกลองที่รวบรวมเคร่ืองมือที่ใชในการตกแตง แกไข สรางสรรคภาพและงานกราฟก 

การแสดงผลของ Toolbox จะแตกตางกันออกไปตาม Workspace ที่เลือกใช แบงเปน 8 กลุม 

ตามลักษณะการใชงาน ดังน้ี  

ตารางท่ี 3-2 กลุมเคร่ืองมือสำหรับเคลื่อนยายวัตถุและสราง Selection 

เคร่ืองมือ รูปแบบการทำงาน 

Move Tool ใชเคลื่อนยายวัตถุหรือรูปภาพไปยังตำแหนงที่ตองการ 

Artboard Tool  ใชสราง Artboard ในเพิ่มหรือลดพื้นที่การทำงาน  

Rectangular Marquee Tool   ใชสราง Selection รูปทรงสี่เหลี่ยม  

Elliptical Marquee Too   ใชสราง Selection รูปทรงกลมหรือทรงรี 

Single Row Marquee Tool ใชสราง Selection รูปทรงเสนตรงแนวนอน ความสูง 1 พิกเซล 

Single Column Marquee Tool ใชสราง Selection รูปทรงเสนตรงแนวต้ัง ความกวาง 1 พิกเซล 

Lasso Tool ใชสราง Selection แบบรูปทรงอิสระ  

Polygonal Lasso Tool  ใชสราง Selection แบบเหลี่ยมมุม 

ภาพท่ี 3-15 วิธีบันทึกคาเคร่ืองมือที่ตองใชเปนประจำ 

 

1 

เลือกเครื่องมือ 

ที่ตองการบันทึก 

2 กำหนดคาเครื่องมือ

ตามที่ตองการ 
3 คลิกปุมสามเหลี่ยม 

4 
คลิกปุม 

สี่เหลี่ยมพับมมุ 

5 

ต้ังชื่อ 

6 

คลิก Ok 
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เคร่ืองมือ รูปแบบการทำงาน 

Magnetic Lasso Tool  ใชสราง Selection ในพื้นที่ที่มีขอบของวัตถุชัดเจน โดยการคลิก

แลวลากเมาสไปตามขอบวัตถุ 

Quick Selection Tool  ใชสราง Selection ในพื้นที่ที่มีขอบของวัตถุชัดเจน โดยการคลิก

เมาสคางไวแลวลากเมาสผานวัตถุ 

Magic Wand Tool  ใชสราง Selection ในพื้นที่ที่มีสีใกลเคียงกัน  

หมายเหตุ. (Patterson, 2020; เกียรติพงศ บุญจิตร, 2560) 

ตารางท่ี 3-3 กลุมเคร่ืองมือสำหรับการตัดภาพหรือวัตถุ 

เคร่ืองมือ รูปแบบการทำงาน 

Crop Tool ใชตัดภาพใหเล็กลงเหลือเฉพาะสวนที่ตองการ 

Perspective Crop Tool ใชตัดภาพที่มีปญหาทางดานมุมมองใหกลายเปนมุมแบบปกติ 

Slice Tool ใชตัดภาพออกเปนชิ้นเล็ก ๆ 

Slice Select Tool ใชปรับแตงภาพที่ตัดดวยเคร่ืองมือ Slice Tool 

หมายเหตุ. (Patterson, 2020; เกียรติพงศ บุญจิตร, 2560) 

ตารางท่ี 3-4 กลุมเคร่ืองมือสำหรับวัดคาตาง ๆ 

เคร่ืองมือ รูปแบบการทำงาน 

Eyedropper Tool ใชเลือกสีที่ตองการไปใชงาน 

3D Material Eyedropper Tool ใชเลือกสีหรือพื้นผิวที่ตองการไปใชในงาน 3D 

Color Sampler Tool ใชแสดงตัวอยางของสี โดยแสดงไดสูงสุด 4 สีตอคร้ัง 

Ruler Tool ใชวัดระยะตามตำแหนงที่ตองการ 

Note Tool ใชแทรกขอความในโปรเจค สำหรับการทำงานรวมกับผูอ่ืน 

Count Tool ใชนับจำนวนวัตถุในภาพหรือให Photoshop นับจำนวน

พื้นที่ในภาพใหโดยอัตโนมัติ 

หมายเหตุ. (Patterson, 2020; เกียรติพงศ บุญจิตร, 2560) 
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ตารางท่ี 3-5 กลุมเคร่ืองมือสำหรับการรีทัชภาพ 

เคร่ืองมือ รูปแบบการทำงาน 

Spot Healing Brush Tool ใชลบสิวและแกไขจุดบกพรองเล็ก ๆ  

Healing Brush Tool ใชซอมแซมจุดบกพรองขนาดใหญ  โดยการกดปุม Alt (Win) / 

Option (Mac) คางไวแลวคลิกสุมตัวอยางจากพื้นผิวที่ดี แลว

คลิกทับบริเวณที่มีปญหาเพื่อซอมแซม 

Patch Tool ใชซอมแซมพื้นผิวขนาดใหญ โดยการวาดโครงรางอิสระรอบ ๆ

บริเวณที่มีปญหา 

Content-Aware Move Tool ใชสำหรับยายสวนของรูปภาพไปยังพื้นที่อ่ืน โดยโปรแกรมจะทำ

การเติมพื้นหลังใหดวย 

Red Eye Tool ใชแกไขตาสีแดงที่สะทอนแสงแฟลชจากกลอง 

Clone Stamp Tool ใชแกไขพื้นผิวที่มีปญหาโดยการก็อปปพื้นผิวมาแลวแปะทับ 

Pattern Stamp Tool ใชเพื่อแตม Pattern ลงบนรูปภาพ โดยสามารถเลือก Pattern 

ไดที่ Option bar 

Eraser Tool ใชลบพื้นที่ที่ไมตองการออก  

Background Eraser Tool ใชลบพื้นหลังที่มีสีใกลเคียงกันออกจากภาพ 

Magic Eraser Tool ใชลบพื้นที่ที่มีสีใกลเคียงกันออกจากภาพ โดยการคลิกแคคร้ัง

เดียว 

Blur Tool  ทำใหภาพเบลอขึ้นดวยการคลิกหรือลากเมาสในบริเวณที่

ตองการ 

Sharpen Tool  ทำใหภาพชัดขึ้นดวยการคลิกหรือลากเมาสในบริเวณที่ตองการ 

Smudge Tool  ใชเกลี่ยสีดวยการคลิกหรือลากเมาสในบริเวณที่ตองการ 

Dodge Tool ปรับใหภาพสวางขึ้น ดวยการคลิกหรือลากเมาสในบริเวณที่

ตองการ 

Burn Tool  ปรับใหภาพมืดขึ้น ดวยการคลิกหรือลากเมาสในบริเวณที่

ตองการ 

Sponge Tool  เพิ่มหรือลดความอ่ิมตัวของสี ดวยการคลิกหรือลากเมาสใน

บริเวณที่ตองการ 

หมายเหตุ. (Patterson, 2020; เกียรติพงศ บุญจิตร, 2560) 
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ตารางท่ี 3-6 กลุมเคร่ืองมือสำหรับการระบายสีและการลงสี 

เคร่ืองมือ รูปแบบการทำงาน 

Brush Tool ใชระบายสี ทั้งแบบสีพื้นและแบบลวดลาย 

Pencil Tool ใชระบายสีแบบเดียวกับ Brush Tool แตขอบที่ไดจะมีความ

หยาบกวา Brush Tool 

Color Replacement Tool  ใชเปลี่ยนสีของภาพโดยการระบายทับลงไป 

Mixer Brush Tool  เปนแปรงแบบผสม ใชแปลงภาพถายใหเปนภาพวาด 

History Brush Tool ใชยอนกลับการทำงานของแปรง โดยการลากเมาสไปบนภาพ 

Art History Brush Tool  ใชแปลงภาพถายใหกลายเปนภาพวาด 

Gradient Tool ใชไลระดับสี 

Paint Bucket Tool ใชเทสีหรือลวดลาย  

Foreground-Background ใชกำหนดสีพื้นหนาและพื้นหลัง 

หมายเหตุ. (Patterson, 2020; เกียรติพงศ บุญจิตร, 2560) 

ตารางท่ี 3-7 กลุมเคร่ืองมือสำหรับการสรางเวคเตอรและตัวอักษร 

เคร่ืองมือ รูปแบบการทำงาน 

Pen Tool ใชวาดเสนพาธที่เปนเสนตรงและเสนโคง  

Freeform Pen Tool ใชวาดเสนพาธแบบอิสระ สามารถปรับแตงไดในภายหลัง 

Curvature Pen Tool  ใชวาดเสนพาธที่เปนเสนโคง 

Add Anchor Point Tool  ใชเพิ่มจุดยึดในเสนพาธ เพื่อใหปรับแตงเสนพาธไดละเอียด

ขึ้น 

Delete Anchor Point Tool  ใชลบจุดยึดออกจากเสนพาธ 

Convert Point Tool  ใชปรับเสนพาธและจุดยึดใหเปนเสนโคงหรือเปนมุม 

Path Selection Tool ใชยายตำแหนงของเสนพาธ 

Direct Selection Tool ใชปรับแตงเสนพาธและจุดยึด 

Horizontal Type Tool ใชสรางขอความแนวนอน 

Vertical Type Tool ใชสรางขอความแนวต้ัง 

Horizontal Type Mask Tool ใชสรางขอความแนวนอนแบบ Selection 

Vertical Type Mask Tool  ใชสรางขอความแนวต้ังแบบ Selection 
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เคร่ืองมือ รูปแบบการทำงาน 

Rectangle Tool  ใชสรางรูปทรงสี่เหลี่ยม 

Rounded Rectangle Tool  ใชสรางรูปทรงสี่เหลี่ยมของมน 

Ellipse Tool ใชสรางรูปทรงกลมและทรงรี 

Polygon Tool ใชสรางรูปทรงหลายเหลี่ยม 

Line Tool ใชสรางเสนตรง 

Custom Shape Tool ใชสรางรูปทรงอิสระที่โปรแกรมจัดเตรียมให 

หมายเหตุ. (เกียรติพงศ บุญจิตร, 2560) 

ตารางท่ี 3-8 กลุมเคร่ืองมือสำหรับสำหรับการจัดการมุมมองของภาพ 

เคร่ืองมือ รูปแบบการทำงาน 

Hand Tool ใชเลื่อนดูสวนตาง ๆ ของภาพเมื่อมีการขยายภาพ 

Rotate View Tool ใชเอียงภาพในมุมตาง ๆ  

Zoom Tool ใชยอ-ขยายมุมมองภาพ 

หมายเหตุ. (Patterson, 2020; เกียรติพงศ บุญจิตร, 2560) 

ตารางท่ี 3-9 กลุมเคร่ืองมือสำหรับการจัดการโหมดของหนาจอ 

เคร่ืองมือ รูปแบบการทำงาน 

Edit in Standard Mode - Edit in       

Quick Mask Mode 

ใชแสดงและแกไขภาพในโหมดปกติและในโหมด 

Quick Mask 

Standard Screen Mode  แสดงหนาจอในแบบโหมดปกติ 

Full Screen Mode with Menu Bar  แสดงแบบเต็มหนาจอโดยไมมีไตเต้ิลบาร 

Full Screen Mode  แสดงแบบเต็มหนาจอโดยมีพื้นหลังสีดำ 

หมายเหตุ. (เกียรติพงศ บุญจิตร, 2560) 

 

 Toolbox จะมีการรวมเครื่องมือที่ใชงานเหมือนกันแตคนละรูปแบบใหอยูในปุมเดียวกัน โดยจะมี

สามเหลี่ยมเล็กอยูดานลางขวาของปุม หากตองการใชเคร่ืองมือใหคลิกคางไว หนาตางที่แสดงเคร่ืองมือยอยจะ

ปรากฎขึ้น 
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4. Panel เปนหนาตางที่ใชทำงานกับรูปภาพในแบบตาง ๆ เชน Color Panel ใชสำหรับเลือกสี 

Layers Panel ใชสำหรับจัดการกับเลเยอร History Panel ใชสำหรับยอนการทำงานหลาย ๆ 

ขั้นตอน เปนตน  

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 3-17 ตัวอยาง Character Panel และ Swatches Panel 

  

ภาพท่ี 3-16 เคร่ืองมือยอยของ Selection  
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การยอ-ขยาย Panel สามารถทำไดโดยการคลิกปุม         หรือ         ดานมุมบนขวาของ

หนาตาง 

 

 

 

 

 

 

 

 

 

 

การปด Panel ใหคลิกขวาที่ Panel แลวเลือก Close เพื่อปด Panel เดียว หรือ Close 

Tab Group เพื่อปด Panel ทั้งกลุม 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 3-19 การปด Panel 

ภาพท่ี 3-18 การยอ-ขยายของ Panel 

 



43 
 

การซอน-แสดง Panel ใชสำหรับซอน Panel ที่ยังไมตองการใชงานและใหแสดง Panel ที่

ตองการใชงาน เพื่อเปนการประหยัดพื้นที่ในการทำงาน โดยการดับเบิลคลิกที่ Panel 

 

 

 

 

 

 

 

 

 

 

 

หากตองการใชงาน Panel อ่ืน  ๆ นอกเหนือจากที่โปรแกรมมีให สามารถเลือกใชงานไดจาก

แถบ Menu Bar -> Window 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 3-21 การเรียกใชงาน Panel 

ภาพท่ี 3-20 การซ่อน-แสดง Panel 
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5. Workspace Menu คือการกำหนดรูปแบบของการแสดงเครื่องมือ พาเนลตาง ๆ  ใหเหมาะสม

กับรูปแบบของงาน โดยโปรแกรมจะเลือกเครื่องมือที่เราจำเปนจะตองใชกับงานมาให โดย 

Adobe Photoshop CC มีใหเลือกอยู 6 รูปแบบ คือ  

1) Essentials [Default] เปน Workspace พื้นฐานที่โปรแกรมกำหนดใหเมื่อเปด

ใชงานคร้ังแรก เหมาะกับการใชงานทั่วไป  

 

 

 

 

 

 

 

2) 3D เหมาะกับการสรางงานในรูปแบบสามมิติ 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 3-22 การทำงานใน Workspace Essentials [Default] 

ภาพท่ี 3-23 การทำงานใน Workspace 3D 
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3) Graphic and Web เหมาะกับงานดานกราฟกและเว็บไซตทั่วไป 

 

 

 

 

 

 

 

 

 

4) Motion เหมาะกับงานดานแอนิเมชัน ทำภาพใหเคลื่อนไหว 

 

 

 

 

 

 

 

 

 

ภาพท่ี 3-24 การทำงานใน Workspace Graphic and Web 

ภาพท่ี 3-25 การทำงานใน Workspace Motion 
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5) Painting เหมาะกับงานดานการวาดรูป ระบายสี 

 

 

 

 

 

 

 

 

6) Photography เหมาะกับงานดานภาพถาย ปรับความสวางรูป ปรับแสงเงาของ

ภาพ 

 

 

 

 

 

 

 

 

ภาพท่ี 3-26 การทำงานใน Workspace Painting 

ภาพท่ี 3-27 การทำงานใน Workspace Photography 
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 การเรียกใชงาน Workspace สามารถทำได 2 วิธี คือ 

1) คลิกเลือก Window ตรง Menu Bar เลื่อนเมาสไปที่คำวา Workspace แลวคลิกเลือก 

Workspace ตามตองการ 

 

 

 

 

 

 

 

 

 

2) คลิกปุม               มุมบนขวาของโปรแกรม แลวเลือก Workspace ตามตองการ 

 

 

 

 

 

 

 

 

    

ภาพท่ี 3-29 การเรียกใชงาน Workspace โดยการคลิกปุม              มุมบนขวาของโปรแกรม 

ภาพท่ี 3-28 การเรียกใชงาน Workspace โดยการคลิก Window ตรง Menu Bar  
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6. Artboard คือ พื้นที่สำหรับการทำงาน เปรียบเสมือนกระดาษหรือผืนผาใบ ในไฟลงาน 1 ไฟล

สามารถมี Artboard ไดมากกวา 1 ชิ้นงาน  

 

 

 

 

 

 

 

 

 

3.5    คียลัดในการใชงานของโปรแกรม Adobe Photoshop cc 

 คียลัด คือ การเรียกใชคำสั่งของโปรแกรม โดยการกดบนแปนพิมพ จะชวยใหทำงานไดอยางรวดเร็ว

ยิ่งขึ้น โดยแยกเปนหมวดหมูดังตารางดังตอไปน้ี 
 

ตารางท่ี 3-10 คียลัดคำสั่ง File 

คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

New Ctrl + N Command + N 

Open Ctrl + O Command + O 

Open as Alt + Shift + Ctrl + O Option + Shift + Command + O 

Close Ctrl + W Command + W 

Close All Alt + Ctrl + W Option + Command + W 

Close and Go to Bridge Shift-Ctrl-W Shift-Command-W 

Save Ctrl + S Command + S 

Save as Shift + Ctrl + S Shift + Command + S 

Export As  Alt + Shift + Ctrl + W Option + Shift + Command + W 

ภาพท่ี 3-30 พื้นที่การทำงานของ Artboard 
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คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

Save for Web Alt + Shift + Ctrl + S Option + Shift + Command + S 

Exit Ctr l+ Q Command + Q 

หมายเหตุ. (Default keyboard shortcuts, 2021) 

 

ตารางท่ี 3-11 คียลัดคำสั่ง Edit 

คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

Undo Ctrl + Z Command + Z 

Redo Shift + Ctrl + Z Shift + Command + Z 

Cut Ctrl + X Command + X 

Copy Ctrl + C Command + C 

Paste Ctrl + V Command + V 

Paste in Place Shift + Ctrl + V Shift + Command + V 

Search Ctrl + F Command + F 

Free Transform Ctrl + T Command + T 

หมายเหตุ. (Default keyboard shortcuts, 2021) 

 

ตารางท่ี 3-12 คียลัดคำสั่ง Tool 

คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

Move tool V V 

Rectangular Marquee tool         

Elliptical Marquee tool               
M M 

Lasso tool                            

Polygonal Lasso tool               

Magnetic Lasso tool 

L L 

Crop tool                                    

Slice tool                                    

Slice Select tool 

C C 

Eyedropper tool                            

Color Sampler tool                      
I I 



50 
 

คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

Ruler tool                                   

Note tool 

Spot Healing Brush tool                 

Healing Brush tool                      

Patch tool                                    

Red Eye tool 

J J 

Brush tool                                   

Pencil tool                                

Color Replacement tool                 

Mixer Brush tool 

B B 

Clone Stamp tool                     

Pattern Stamp tool 
S S 

History Brush tool                          

Art History Brush tool 
Y Y 

Eraser tool                         

Background Eraser tool               

Magic Eraser tool 

E E 

Gradient tool                             

Paint Bucket tool 
G G 

Dodge tool                                           

Burn tool                                      

Sponge tool 

O O 

Pen tool                                  

Freeform Pen tool 
P P 

Horizontal Type tool                           

Vertical Type tool                        

Horizontal Type mask tool                 

Vertical Type mask tool 

T T 

Path Selection tool                          

Direct Selection tool 
A A 
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คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

Rectangle tool                                    

Rounded Rectangle tool              

Ellipse tool                                     

Polygon tool                                    

Line tool                                      

Custom Shape tool 

U U 

Hand tool H H 

Rotate View tool R R 

Zoom tool Z Z 

Default Foreground/Background 

colors 

D D 

Switch Foreground/Background 

colors 

X X 

สลับ Standard และ Quick Mask 

modes 

Q Q 

Perspective Crop tool C C 

Artboard tool V V 

Rotate View tool R R 

หมายเหตุ. (Default keyboard shortcuts, 2021) 

 

ตารางท่ี 3-13 คียลัดคำสั่ง Image 

คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

Adjustments  

       Levels 

       Curves 

       Hue/Saturation 

       Color Balance 

       Black & White 

       Invert 

 

Ctrl + L 

Ctrl + M 

Ctrl + U 

Ctrl + B 

Alt + Shift + Ctrl + B 

Ctrl + I 

 

Command + L 

Command + M 

Command + U 

Command + B 

Shift + Command + Option + B 

Command + I 
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คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

       Desaturate Shift + Ctrl + U Shift + Command + Option + U 

Auto Tone Shift + Ctrl + L Shift + Command + L 

Auto Contrast Alt + Shift + Ctrl + L Option + Shift + Command + L 

Auto Color Shift + Ctrl + B Shift + Command + B 

Image Size Alt + Ctrl + I Option + Command + I 

Canvas Size Alt + Ctrl + C Option + Command + C 

หมายเหตุ. (Default keyboard shortcuts, 2021) 

 

ตารางท่ี 3-14 คียลัดคำสั่ง Layer  

คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

New Layer Shift + Ctrl + N Shift + Command + N 

New Layer Via Copy Ctrl + J Command + J 

New Layer Via Cut Shift + Ctrl + J Shift + Command + J 

Group Layers Ctrl + G Command + G 

Ungroup Layers  Shift + Ctrl + G Shift + Command + G 

Hide Layers Ctrl + , Command + , 

Arrange                                  

 Bring to Front 

 Bring Forward 

 Send Backward 

 Send to Back 

 

Shift + Ctrl + ] 

Ctrl + ] 

Ctrl + [ 

Shift + Ctrl + [ 

 

Shift + Command + ] 

Command + ] 

Command + [ 

Shift + Command + [ 

Lock Layers Ctrl + / Command + / 

Select all layers Ctrl + Alt + A Command + Option + A 

Merge visible layers Ctrl + Shift + E Command + Shift + E 

Merge layers เลือกเลเยอรที่ตองการ + Ctrl + 

E 

เลือกเลเยอรที่ตองการ + 

Command + E 

หมายเหตุ. (Default keyboard shortcuts, 2021) 
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ตารางท่ี 3-15 คียลัดคำสั่ง Type 

คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

สราง Text layer ใหม Shift-click Shift-click 

จัดขอความใหชิดซาย ตรงกลาง 

ขวา 

Horizontal Type tool + Ctrl 

+ Shift + L, C, R 

Horizontal Type tool + 

Command + Shift + L, C, R 

จัดขอความใหชิดดานบน ตรง

กลาง ดานลาง 

Vertical Type tool + Ctrl + 

Shift + L, C, R 

Vertical Type tool + 

Command + Shift + L, C, R 

horizontal scale 100% Ctrl + Shift + X Command + Shift + X 

vertical scale 100% Ctrl + Shift + Alt + X Command + Shift + Option 

+ X 

หมายเหตุ. (Default keyboard shortcuts, 2021) 

 

ตารางท่ี 3-16 คียลัดคำสั่ง Select 

คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

Select All Ctrl + A Command + A 

Deselect Ctrl + D Command + D 

Reselect Shift + Ctrl + D Shift + Command + D 

Inverse Shift + Ctrl + I Shift + Command + I 

All Layers Alt + Ctrl + A Option + Command + A 

Find Layers Alt + Shift + Ctrl + F Option + Shift + Command + F 

Select and Mask  Alt + Ctrl + R Option + Command + R 

Add Selection Selection Tool + Shift +ลาก

เมาส 

Selection Tool + Shift +ลาก

เมาส 

สลับเคร่ืองมือระหวาง Magnetic 

Lasso tool กับ Lasso tool 

Alt + ลากเมาส Option + ลากเมาส 

สลับเคร่ืองมือระหวาง Magnetic 

Lasso tool กับ Polygonal 

Lasso 

Alt + Click Alt + Click 

Move copy of selection Move tool + Alt + ลากเมาส Move tool + Option + ลากเมาส 

ยาย selection ทีละ 1 pixel Selection tool + ลูกศร Selection tool + ลูกศร 
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หมายเหตุ. (Default keyboard shortcuts, 2021) 

 

ตารางท่ี 3-17 คียลัดคำสั่ง View 

คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

Zoom in Ctrl + (+ +) Command + (+ +) 

Zoom out Ctrl + (+ -) Command + (+ -) 

Fit on Screen Ctrl + 0 Command + 0 

ขยาย 100% Double click + Zoom tool 

หรือ Ctrl + 1 

Double click + Zoom tool 

หรือ Command + 1 

Extras Ctrl + H Command + H 

Show 

 Target Path 

 Grid 

 Guides 

 

Shift + Ctrl + H 

Ctrl + ’ 

Ctrl + ; 

 

Shift + Command + H 

Command + ’ 

Command + ; 

Rulers Ctrl + R Command + R 

Snap Shift + Ctrl + ; Shift + Command + ; 

Lock Guides Alt + Ctrl + ; Option + Command + ; 

สลับไปเคร่ืองมือ Zoom In Control + spacebar Command + spacebar 

สลับไปเคร่ืองมือ Zoom Out Alt + spacebar Option + spacebar 

หมายเหตุ. (Default keyboard shortcuts, 2021) 

 

ตารางท่ี 3-18 คียลัดคำสั่ง Blending modes  

คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

Normal Shift + Alt + N Shift + Option + N 

Dissolve Shift + Alt + I Shift + Option + I 

Behind (Brush tool only) Shift + Alt + Q Shift + Option + Q 

Clear (Brush tool only) Shift + Alt + R Shift + Option + R 

Darken Shift + Alt + K Shift + Option + K 

Multiply Shift + Alt + M Shift + Option + M 

Color Burn Shift + Alt + B Shift + Option + B 



55 
 

คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

Linear Burn Shift + Alt + A Shift + Option + A 

Lighten Shift + Alt + G Shift + Option + G 

Screen Shift + Alt + S Shift + Option + S 

Color Dodge Shift + Alt + D Shift + Option + D 

Linear Dodge Shift + Alt + W Shift + Option + W 

Overlay Shift + Alt + O Shift + Option + O 

Soft Light Shift + Alt + F Shift + Option + F 

Hard Light Shift + Alt + H Shift + Option + H 

Vivid Light Shift + Alt + V Shift + Option + V 

Linear Light Shift + Alt + J Shift + Option + J 

Pin Light Shift + Alt + Z Shift + Option + Z 

Hard Mix Shift + Alt + L Shift + Option + L 

Difference Shift + Alt + E Shift + Option + E 

Exclusion Shift + Alt + X Shift + Option + X 

Hue Shift + Alt + U Shift + Option + U 

Saturation Shift + Alt + T Shift + Option + T 

Color Shift + Alt + C Shift + Option + C 

Luminosity Shift + Alt + Y Shift + Option + Y 

หมายเหตุ. (Default keyboard shortcuts, 2021) 

 

ตารางท่ี 3-19 คียลัดคำสั่งอ่ืน ๆ 

คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

เลือก Foreground color จาก 

color picker 

Painting Tool + Shift + Alt + 

คลิกขวา + ลากเมาส 

Painting Tool + Control + 

Option + Command + ลากเมาส 

เลือก Foreground color จาก

ภาพดวยเคร่ืองมือ Eyedropper 

Painting tool + Alt            

หรือ shape tool + Alt 

Painting tool + Option  

หรือ Shape tool + Option 

เลือก Background color Eyedropper tool + Alt-click Eyedropper tool + Option-click 

เติม Foreground color หรือ 

Background color 

Alt + Backspace  

หรือ Control + Backspace 

Option + Delete  

หรือ Command + Delete 
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คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

สลับระหวางการระบายและการ

ลบดวยแปรงเดียวกัน 

กด ` คางไว กด ` คางไว  

ลดขนาดแปรง [ [ 

เพิ่มขนาดแปรง ] ] 

ลดความแข็งของแปรง { { 

เพิ่มความแข็งของแปรง } } 

หมุน Brush ทีละ 1 องศา ลูกศรซาย (ทวนเข็มนาิกา) 

ลูกศรขวา (ตามเข็มนาิกา) 

ลูกศรซาย (ทวนเข็มนาิกา) 

ลูกศรขวา (ตามเข็มนาิกา) 

หมุน Brush ทีละ 15 องศา Shift + ลูกศรซาย (ทวนเข็ม

นาิกา) 

Shift + ลูกศรขวา (ตามเข็ม

นาิกา) 

Shift + ลูกศรซาย (ทวนเข็มนาิกา) 

Shift + ลูกศรขวา (ตามเข็มนาิกา) 

ปดเอกสารที่เปดอยูทั้งหมด 

ยกเวนเอกสารปจจุบัน 

Ctrl + Alt + P Command + Option + P 

หมายเหตุ. (Default keyboard shortcuts, 2021) 

 

3.6   ขอควรระวังในการปฏิบัติงาน 

1. ตรวจสอบความถูกตองของขอมูล เชน ชื่อกิจกรรม วัน เวลา ชื่อผูเขารวมงาน เปนตน ทุกคร้ังกอนการ

ผลิตภาพกราฟก 

2. ตรวจสอบภาพกราฟกทุกคร้ังกอนการบันทึกภาพเพื่อนำไปใช เชน ตัวสะกดถูกหรือไม ใสเอฟเฟกต

ครบทุกเลเยอรหรือไม สีตัวอักษรตรงตามแบบหรือไม เปนตน 

3. สอบถามการใชเครื ่องสลับสัญญาณภาพจากผูรับผ ิดชอบในการถายทอดสดทุกครั้ง เนื่องจาก

ภาพกราฟกที่ใชกับเครื่องสลับสัญญาณภาพแตละเครื่องไมเหมือนกัน ทำใหตองผลิตภาพกราฟก

แตกตางกันออกไปในแตละเคร่ือง 
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บทที่ 4 

เทคนิคการปฏบิัติงาน 

 คูมือการปฏิบัติงานการผลิตภาพกราฟกในการถายทอดสดผานระบบอินเทอรเน็ต โดยใชโปรแกรม 

Adobe Photoshop cc ของกลุมงานพัฒนานวัตกรรมและเทคโนโลย ีการศึกษา สำนักวิทยบริการและ

เทคโนโลยีสารสนเทศ ไดอธิบายขั้นตอนการผลิตภาพกราฟกโดยการใชโปรแกรม Adobe Photoshop cc 

โดยผูจัดทำ ไดแบงวิธีการนำเสนอออกเปน 5 ขั้นตอน ดังน้ี 

4.1  การสรางไฟลเอกสารใน Adobe Photoshop cc 

4.2  การผลิตภาพกราฟกภาพพักหนาจอ 

4.3  การผลิตภาพกราฟกแถบชื่องาน 

4.4  การผลิตภาพกราฟกแถบชื่อผูรวมงาน 

4.5  การบันทึกไฟลภาพกราฟก 

4.1    การสรางไฟลเอกสารใน Adobe photoshop cc 

การสรางไฟลเอกสาร เปนการกำหนดขนาดและความละเอียดของชิ ้นงานใหเหมาะกับงานที่จะ

นำไปใช เพราะงานแตละประเภทจะใชขนาดและความละเอียดที่แตกตางกัน สามารถสรางไฟลเอกสารไดโดย

การไปที่ Menu Bar -> File -> New  จะมีหนาตาง Preset ปรากฏขึ้นมา  

 

 

 

 

 

 

 

 

ภาพท่ี 4-31 การต้ังคาไฟลเอกสาร 
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ดานบนของหนาตาง Preset เปนขนาดไฟลที่โปรแกรมกำหนด โดยแบงเปนประเภทตาง ๆ ดังน้ี 

1) Recent คือ แสดงการใชงานไฟลลาสุด สามารถคลิกเปดไฟลไดจากตรงน้ี 

 

 

 

 

 

 

 

 

 

 

ภาพที่ 4-38 หนาตางการต้ังคาไฟลงาน 

ภาพท่ี 4-32 หนาตาง Preset 

ภาพท่ี 4-33 แสดงการใชงานไฟลลาสุด 
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2) Save คือ ไฟลเอกสารที่ไดบันทึกเก็บไว สวนมากจะเปนไฟลเอกสารที่ใชบอยหรือเปนไฟลที่ได

กำหนดคาเอง เพื่อใหสะดวกกับการทำงาน 

 

 

 

 

 

 

 

 

 

3) Photo ใชสำหรับการทำงานกับภาพถาย เปนขนาดของกระดาษสำหรับอัดภาพถาย เชน 

Landscape 4x6, Portrait 5x7 เปนตน 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-34 ไฟลเอกสารที่ไดบันทึก  

ภาพท่ี 4-35 ขนาดของไฟลเอกสารทีโ่ปรแกรมกำหนดไวในประเภท Photo  
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4) Print ใชกับงานสิ่งพิมพ เปนขนาดสำหรับกระดาษ เชน Letter, Legal, Tabloid, A3, A4, A5, B3, 

B4 เปนตน 

 

 

 

 

 

 

 

 

 

5) Art & Illustration ใชกับงานวาดรูป ศิลปะ ภาพประกอบตางๆ มีขนาด poster, Postcard, 1000 

pixel grid เปนตน 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-36 ขนาดของไฟลเอกสารที่โปรแกรมกำหนดไวในประเภท Print 

ภาพท่ี 4-37 ขนาดของไฟลเอกสารที่โปรแกรมกำหนดไวในประเภท Art & Illustration 



61 
 

6) Web ใชกับงานทำเว็บไซตตาง ๆ มีหลายรูปแบบใหเลือก เชน Web Most Common, Web 

Medium, Desktop HD Design เปนตน 

 

 

 

 

 

 

 

 

 

7) Mobile ใชสำหรับการต้ังคาขนาดหนาจอมือถือ เชน iPhone, iPad, Android, Microsoft Surface, 

Mobile Design เปนตน 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-38 ขนาดของไฟลเอกสารที่โปรแกรมกำหนดไวในประเภท Web 

ภาพท่ี 4-39 ขนาดของไฟลเอกสารที่โปรแกรมกำหนดไวในประเภท Mobile 
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8) Film & Video ใหสำหรับการทำงานกับไฟลวิดีโอ เชน HDTV, DVCPRO HD, NTSC DV, FILM (4K) 

เปนตน 

 

 

 

 

 

 

 

 

 

 

 

 

 

 ทางดานขวาของหนาตาง Preset จะเปนรายละเอียดการกำหนดคาตาง ๆ ของไฟลเอกสาร มี

รายละเอียดดังน้ี (Create documents, 2019) 

1) Untitled-1 คือ ชองต้ังชื่อไฟลเอกสาร  

2) Width คือ ความกวางของไฟลเอกสาร มีหนวยเปน pixel, Inches, Centimeters, 

Millimeters, Point และ Picas  

3) Height คือ ความยาวของไฟลเอกสาร มีหนวยเปน pixel, Inches, Centimeters, Millimeters 

Point และ Picas  

4) Orientation คือ ต้ังคาไฟลเอกสารใหเปนแนวต้ังหรือแนวนอน โดยการสลับคาความกวางและ

ความสูงที่ไดกำหนดไว  

ภาพท่ี 4-41 รูปแบบตาง ๆ ที่โปรแกรมกำหนด 

ภาพท่ี 4-40 ขนาดของไฟลเอกสารที่โปรแกรมกำหนดไวในประเภท Film & Video 
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5) Resolution คือ ความละเอียดของไฟลเอกสาร สามารถกำหนดขนาดและหนวยไดเอง โดยหนวย

จะม ีPixel/Inches และ Pixel/Centimeters ใชสำหรับงานสิ่งพิมพ 

6) Color Mode คือ โหมดสีของไฟลเอกสาร ประกอบไปดวย โหมดสี Bitmap, Grayscale, RGB 

Color, CMYK Color และ Lab Color 

7) Background Contents คือ สีพื้นหลังของไฟลเอกสาร ประกอบไปดวย Black, White, 

Background Color, Transparent และ Custom 

8) Advanced options คือ การต้ังคาโปรไฟลสีและอัตราสวนพิกเซลของเอกสาร  

ในการสรางไฟลเอกสาร สามารถเลือกขนาดและความละเอียดของไฟลเอกสารตามที่โปรแกรม

กำหนดมาให หรือกำหนดคาเองไดเชนกัน เมื่อกำหนดขนาดไฟลเอกสารแลว ใหคลิกปุม Create เพื่อสรางไฟล

เอกสาร  

 

 

 

 

 

 

  

 

 

 

 

 

 

1 ต้ังชื่อไฟลเอกสาร 

2ความกวางของไฟลเอกสาร 

5 ความละเอียดของไฟลเอกสาร 

3 ความยาวของไฟลเอกสาร 

6 โหมดสีของไฟลเอกสาร 

7 สีพื้นหลังของไฟลเอกสาร 

8 ต้ังคาโปรไฟลสีและอัตราสวน

พิกเซลของเอกสาร 

4 
ต้ังคาไฟลเอกสารใหเปนแนวต้ัง

หรือแนวนอน 

ภาพท่ี 4-42 หนาตาง Preset Detail 

9 คลิกปุม Create เพื่อสราง

ไฟลเอกสาร 
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4.2 การผลิตกราฟกภาพพักหนาจอ 

 กราฟกภาพพักหนาจอเปนกราฟกที่ใชบอกชื่องาน ว ัน เวลาและสถานที ่จ ัดงาน ใช ก อนการ

ถายทอดสด ชวงพกัระหวางการถายทอดสดและหลังจบการถายทอดสด สำหรับประชาสัมพันธกิจกรรมตาง ๆ 

ของทางมหาวิทยาลัย โดยในคูมือการจัดทำเลมนี้ไดนำเสนอการจัดทำกราฟกภาพพักหนาจอในงานซอมรับ

ปริญญา สำหรับขั้นตอนในการผลิตกราฟกภาพพักหนาจอโดยใชโปรแกรม Adobe Photoshop cc ผูจัดทำได

นำเสนอวิธีการผลิตกราฟกภาพพักหนาจอ โดยมีขั้นตอนวิธีการดังตอไปน้ี 

1. เปดโปรแกรม Adobe Photoshop cc 

 

 

 

 

 

 

ภาพท่ี 4-43 ไฟลเอกสารที่สรางสำเร็จ 
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ภาพท่ี 4-45 หนาจอเมื่อโปรแกรม Adobe Photoshop cc เปดใชงาน 

 

ภาพท่ี 4-44 วิธีเปดโปรแกรม Adobe Photoshop cc 

1 

คลิกที่แถบเมนู Start -> 

Adobe Photoshop cc  
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2. สรางไฟลเอกสาร 

 

 

 

  

 

 

 

 

3. เน่ืองจากเปนการทำงานกับเคร่ืองสลับสัญญาณภาพและเสียงที่มีคุณสมบัติเปน HDTV 1080p 

ใหต้ังคาดังน้ี  

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-46 การสรางไฟลเอกสาร 

คลิกที่ Menu Bar -> 

File -> New 

2.1 

เลือก Film & Movie 

3.1 

3.2 เลือก HDTV 1080p 1920 x 1080 px @ 72 ppi 

ภาพท่ี 4-47 การต้ังคาไฟลเอกสาร  
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ภาพท่ี 4-48 การกำหนดภาพพื้นหลังของไฟลเอกสาร 

3.3 เลือก Background Contents เปน Transparent 

ภาพท่ี 4-49 การต้ังชื่อไฟลเอกสาร 

ต้ังชื่อไฟลเอกสาร  ในที่น้ีต้ังชื่อวา Background  3.4 

3.5 

คลิกปุม Create 

เพื่อสรางไฟลเอกสาร 
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4. นำไฟลรูปเขาสูโปรแกรม  

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-50 หนาจอแสดงไฟลเอกสาร Background  ที่ไดสรางไว 

ภาพท่ี 4-51 หนาจอแสดงการเปดไฟลรูป 

4.1 

คลิกที่ File -> Open  
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ภาพท่ี 4-52 หนาจอแสดงการเลือกไฟลรูป 

4.3 

คลิก Open  ไฟลรูปจะ

ปรากฏในขึ้นมาในโปรแกรม 

4.2 คลิกเลือกไฟลรูปที่ตองการ 

ภาพท่ี 4-53 รูปภาพที่เลือกในไฟลเอกสาร Background 
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5. คัดลอกไฟลรูปที่เปด นำไปวางไวในไฟลเอกสาร Background โดยมีขั้นตอนดังน้ี 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-54 คลิกเลือก Layer รูปภาพ ใน Layer Panel 

 

5.1 ไปที่ Layer Panel คลิก Layer รูปภาพที่ตองการ Copy หากที่ Layer มีรูป

กุญแจล็อกใหทำการปลดล็อก Layer โดยการคลิกที่รูปกุญแจหน่ึงคร้ัง 

ภาพท่ี 4-55 คัดลอกรูปภาพโดยใช Menu Edit 

5.2 

ไปที่ Menu Bar -> Edit -> Copy หรือใช 

คีย ล ัด (Shortcut) โดยการกด Ctrl+C ที่

คียบอรดเพ ื่อทำการคัดลอก Layer ไฟล

รูปภาพ 
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ภาพท่ี 4-56 เลือกไฟลเอกสารที่ตองการวางรูปที่คัดลอกมา 

5.3 เลือกไฟลเอกสารที่ตองการวางรูป โดยการคลิกที่ชื่อไฟลเอกสาร 

ภาพท่ี 4-57 วาง Layer ที่ Copy มา โดยใช Menu -> Edit 

5.4 

วางไฟลรูปภาพดวยคำสั่ง  Menu Bar -> 

Edit -> Paste หรือใช คียลัด (Shortcut)  

โดยการกด Ctrl+V 
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6. จัดวางรูปภาพ โดยใช คำสั ่ ง Edit -> Transform และ Move Tool ในการย อขยายและ

เคลื่อนยายรูปภาพ โดยใหจุดเดนของภาพคือมือที่กำลังรับใบปริญญาอยูดานบนของ Artboard 

เน่ืองจากตองเหลือพื้นที่ดานลางสำหรับขอความ 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-58 ไฟลรูปภาพในไฟลเอกสาร Background 

ภาพท่ี 4-60 การเลือก Move Tool ภาพท่ี 4-59 ใชคำสั่ง Edit -> Transform  

Move Tool 

คำสั่ง Edit -> 

Transform 
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7. ใส Filter Gaussian blur เพื่อลดความคมชัดของรูป  

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-61 การจัดวางรูปภาพใหเหมาะสมกับขนาดของพื้นที่ 

7.1 

ใชคำสั่งที่ Menu Bar -> Filter -> 

Blur -> Gaussian Blur  

ภาพท่ี 4-62 ใส Filter Gaussian blur 
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จะปรากฏหนาตาง Gaussian Blur กำหนดคาดังน้ี 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7.3 

7.2 

ภาพท่ี 4-63 กำหนดคา Radius ใน Filter Gaussian blur 

Radius เปน 4.5 Pixels  

คลิก OK 

ภาพท่ี 4-64 รูปภาพที่ใส Filter Gaussian blur 
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8. สรางขอความ โดยแบงขอความออกเปน 2 สวน คือ ชื่องานและรายละเอียดของงาน 

กำหนดใหแบบตัวอักษรที่ใช คือ DB Chidlom X และตัวอักษรเปนสีขาว ดังน้ี 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

8.1 

คลิกเลือก Horizontal Type Tool 

ภาพท่ี 4-65 Horizontal Type Tool ที ่Toolbox 

กำหนดคาของขอความชื่องานที่ Option bar  ดังน้ี เลือก DB Chidlom X สไตล Bold ขนาด

ตัวอักษร 80 pt  ความคมของตัวอักษรเลือก Strong กำหนดใหรูปแบบของตัวอักษรอยูตรง

กลางและตัวอักษรมีสีขาว 

8.2 

ภาพท่ี 4-66 Option bar กำหนดรายละเอียดของตัวอักษรกลุมชื่องาน 
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  จัดแตงขอความใหเหมาะสมสวยงามโดยใช Move Tool และ Character Panel 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-68 ยายขอความโดยใช 

                Move Tool 

8.4 ยายขอความโดยใช   

Move Tool  

จัดแตงขอความใหสวยงามเหมาะสม

โดยใช Character Panel 8.4 

ภาพท่ี 4-69 จัดแตงขอความโดยใช                                      

                 Character Panel  

ภาพท่ี 4-67 ขอความที่พิมพลงไป 

คลิกที่ Artboard หน่ึงคร้ัง แลวพิมพขอความ ซอมยอยรวม 

พิธีพระราชทานปริญญาบัตร ประจำปการศึกษา ๒๕๖๑ 
8.3 
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ภาพท่ี 4-72 เรียกใชคำสั่ง Effect Stroke  

                ที ่Layer Panel  

 

 

 

 

 

 

 

 

 

 

 

 

 

ใสขอบของตัวอักษรใหเปนสีมวง โดยการกำหนดคา Stroke ที่ Layer Style สามารถเรียก 

Layer Style ได 2 วิธี ดังน้ี 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-70 ขอความที่จัดแตงสำเร็จ 

ภาพท่ี 4-71 เรียกใชคำสั่ง Effect Stroke  

                ที ่Menu Layer    

8.5 
ใชคำสั่งที่ Menu Bar -> Layer -> 

Layer Style -> Stroke 

หรือดับเบิ้ลคลิกที่ Layer ขอความที่

ตองการใสขอบตัวอักษร ใน Layer 

Panel 

8.5 
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จะปรากฏหนาตาง Layer Style กำหนดคาดังน้ี 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

กำหนด size เปน 4 px  

Position เปน Outside 

Color เลือกสีมวง 

8.7 8.6 คลิกเลือก Stroke 

8.8 

คลิก OK 

ภาพท่ี 4-73 กำหนดคาในหัวขอ Stroke 

ภาพท่ี 4-74 ขอความชื่องานที่จัดทำสำเร็จ  
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เมื่อจัดทำขอความชื่องานสำเร็จ ขั้นตอนตอมาคือ ทำขอความรายละเอียดของงาน โดยคลิก

เลือก Horizontal Type Tool ที่ Toolbox จากน้ันกำหนดรายละเอียดของตัวอักษรที่ Option bar 

ดังน้ี 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-76 ขอความรายละเอียดของงาน 

 

ภาพท่ี 4-75 Option bar กำหนดรายละเอียดของกลุมขอความรายละเอียดของงาน 

รูปแบบของตัวอักษร เลือก DB Chidlom X สไตล Medium ขนาดตัวอักษร 56 pt ความคม

ของตัวอักษรเลือก Strong กำหนดใหรูปแบบของตัวอักษรอยูตรงกลางและใหตัวอักษรมีสีขาว 

8.9 

8.10 
คลิกท่ี Artboard หน่ึงครั้ง พิมพขอความ วันพฤหัสบดีท่ี ๑๕ สิงหาคม ๒๕๖๓ 

ณ หองประชุมชั้น 3 อาคารมงคลอาภา คณะบริหารธุรก ิจ มหาวิทยาลัย

เทคโนโลยีราชมงคลพระนคร  ทำการปรับแตงขอความใหเหมาะสมโดยใช 

Move Tool และ Character Panel 
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ใสขอบของตัวอักษรใหเปนสีมวง โดยกำหนดคา Stroke ที่ Layer Style ดังน้ี 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

8.12 

8.13 

8.11 

กำหนด size เปน 3 px  

Position เปน Outside 

Color เลือกสีมวง 
คลิกเลือก Stroke 

คลิก OK 

ภาพท่ี 4-77 กำหนดคาในหัวขอ Stroke 

ภาพท่ี 4-78 ขอความรายละเอียดของงานที่จัดแตงสำเร็จ 
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ภาพท่ี 4-79 ไฟลภาพพักหนาจอที่จัดทำสำเร็จ 

ภาพท่ี 4-80 ตัวอยางภาพพักหนาจอพิธีไหวครูในการถายทอดสดผาน Facebook live 
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4.3 การผลิตภาพกราฟกแถบชื่องาน 

กราฟกแถบชื่องานสามารถออกแบบไดตามลักษณะของกิจกรรม โดยคูมือการจัดทำเลมน้ีไดนำเสนอ

การจัดทำกราฟกแถบชื่องาน ในงานซอมยอยรวม พิธีพระราชทานปริญญาบัตร ดังน้ันกราฟกจึงมีลักษณะที่

เปนทางการ เรียบงาย โดยการใชสี่เหลี่ยมเปยกปูน สีที่ใชคือสีมวง สีประจำมหาวิทยาลัย แบบตัวอักษรที่ใชคือ 

DB Chidlom แบบตัวอักษรประจำมหาวิทยาลัย และสีตัวอักษรเปนสีขาว ทำใหอานงาย สบายสายตา สำหรับ

ขั้นตอนในการผลิตกราฟกแถบชื่องานโดยใชโปรแกรม Adobe Photoshop cc ผูจัดทำไดนำเสนอวิธีการผลิต

กราฟกชื่องาน โดยมีขั้นตอนวิธีการดังตอไปน้ี  

1. เปดโปรแกรม Adobe Photoshop ขั้นตอนนี้สามารถเลือกไดวาจะสรางไฟลเอกสารใหม

หรือจะเปดไฟลเอกสารที ่ไดทำการบันทึกเอาไว  ในที ่นี ้จะขอเล ือกเปดไฟลเอกสาร 

Background ที่ไดทำภาพพักหนาจอไว 

 

 

 

 

 

ภาพท่ี 4-81 ตัวอยางภาพพักหนาจองานปจฉิมนิเทศนักศึกษาในการถายทอดสดผาน Facebook live  
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ภาพท่ี 4-82 เปดไฟลเอกสารที่ไดบันทึกไวโดยคำสั่ง Open 

1.1 

ไปที่ Menu Bar -> Open   

ภาพท่ี 4-83 เลือกไฟลที่ตองการเปด 

1.3 

1.2 

เลือกไฟลเอกสารที่ตองการเปด 

คลิก Open 
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2. สรางสี่เหลียมผืนผาขึ้นมาโดยใช Rectangle Tool  

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

คลิก Rectangle Tool          

ที่ Toolbox 

ภาพท่ี 4-84 ไฟลเอกสารที่ไดบันทึกไว 

2.1 

ภาพท่ี 4-85  Rectangle Tool ที่ Toolbox 
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คลิกที่ Artboard  หน่ึงคร้ัง จะปรากฏหนาตาง Create Rectangle ในหนาตางบอกขนาด

ของความกวางและความสูงที่ไดกำหนดไวที่ Option bar  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-86 กำหนดคาของแถบชื่อที่ Option bar 

2.2 กำหนดคา Fill เปนสีมวง ความกวางของสี่เหลี่ยม = 1100 px ความสูง = 120 px   

ภาพท่ี 4-88 สี่เหลี่ยมผืนผาที่สรางสำเร็จ 

ภาพท่ี 4-87 หนาตางแสดงขนาดของแถบขอความที่ตองการสราง 

2.4 

คลิกเลือก From Center 

จากน้ันคลิกปุม OK 
2.3 

หากขนาดไมถกูตอง 

สามารถแกไขไดใน

หนาตางน้ี 
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ภาพท่ี 4-89 Move Tool สำหรับเคลื่อนยาย 

2.5 

ใช Move Tool เลื่อน

สี่เหลี่ยมผืนผาลงมาใกลกับเสน

ไกดแนวนอนเสนที่ 3 

ภาพท่ี 4-90 เสนไกดแนวนอนเสนที่ 3 

เสนไกดแนวนอนเสนที่ 3 
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ภาพท่ี 4-91 สี่เหลี่ยมที่ยายลงมาดานลาง 

ภาพท่ี 4-92 คำสั่ง Skew ที่ Menu Bar -> Edit 

2.6 

ใชคำสั่ง Menu Bar -> Edit -> 

Transform -> Skew 

ปรับรูปทรงของสี่เหลี่ยมผืนผาใหเปนสี่เหลี่ยมเปยกปูน 
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3.  พิมพขอความชื่องาน กำหนดใหตัวอักษรที่ใช คือ DB Chidlom X  สีตัวอักษรคือสีขาว  

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-94 สี่เหลี่ยมเปยกปูนที่สรางสำเร็จ 

2.7 

ภาพท่ี 4-93 ปรับรูปทรงของสี่เหลี่ยมผืนผาใหเปนสี่เหลี่ยมเปยกปูน 

คลิกคางที่จุดตรงกลางดานบน เลื ่อนไปทางขวา

จนไดองศาที่ตองการ จากน้ันกด Enter หน่ึงคร้ัง 

 

3.1 

คลิกเลือก 

Horizontal Type Tool 

ภาพท่ี 4-95 Horizontal Type Tool 
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ภาพท่ี 4-96 Option bar กำหนดรายละเอียดของตัวอักษร 

3.2 
กำหนดรายละเอียดดังน้ี เลือก DB Chidlom X สไตล Bold ขนาดตัวอักษร 46 pt 

กำหนดใหรูปแบบของตัวอักษรอยูตรงกลางและใหตัวอักษรมีสีขาว 

ภาพท่ี 4-97 ขอความที่พิมพลงไป 

ยายขอความโดยใช Move Tool  3.3 3.3 จัดแตงขอความใหสวยงามเหมาะสม

โดยใช Character Panel 

ภาพท่ี 4-98 ยายและจัดแตงขอความใหเหมาะสมดวย Move Tool  และ Character Panel  
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ภาพท่ี 4-99 ขอความที่จัดแตงสำเร็จ 

ภาพท่ี 4-101 ตัวอยางกราฟกแถบชื่องานในการสัมมนาผาน Facebook live 

ภาพท่ี 4-100 ตัวอยางกราฟกแถบชื่อการบรรยาย กิจกรรมปฐมนิเทศนักศึกษา          

                  ในการถายทอดสดผาน Facebook live 
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4.4 การผลิตภาพกราฟกแถบชื่อผูรวมงาน 

  กราฟกแถบชื่อผูรวมงานจะเปนกราฟกบอกชื่อของผูดำเนินงานในชวงตาง ๆ เชน พิธีกร ผู

ดำเนินรายการ ประธานในงานหรือวิทยากรผูใหความรู เพื่อบอกกับผูรับชมใหทราบวาเปนใครและเปนการให

เกียรติแกบุคคลนั้น ๆ  กราฟกแถบชื่อสวนมากจะมีลักษณะเหมือนกับกราฟกแถบชื่องานหรืออาจมีลักษณะ

แตกตางกันไมมาก เพื่อใหลักษณะของกราฟกมีความเปนอันหนึ่งอันเดียวกัน โดยในคูมือการจัดทำเลมน้ี         

ไดนำเสนอการจัดทำกราฟกแถบชื่อผูรวมงาน ในงานซอมยอยรวม พิธีพระราชทานปริญญาบัตร ดังน้ันกราฟก

จึงมีลักษณะเดียวกับกราฟกแถบชื่องาน คือ มีลักษณะเปนสี่เหลี่ยมเปยกปูนสีมวง แตจะมีแถบสีขาวเล็ก ๆ อยู

ชวงลางเพือ่แบงขอความออกเปนสองสวน คือ สวนของชื่อ - นามสกุลของผูรวมงานและสวนของตำแหนง

หนาที่ แบบตัวอักษรที่ใชคือ DB Chidlom สีตัวอักษรเปนสีขาว สำหรับขั้นตอนในการผลิตกราฟกแถบชื่องาน

โดยใชโปรแกรม Adobe Photoshop cc ผูจัดทำไดไดนำเสนอวิธีการผลิตกราฟกชื่องาน โดยมีขั้นตอนวิธีการ

ดังตอไปน้ี  

1. สรางสี่เหลี่ยมผืนผาขึ้นมา 2 รูป แบงเปนสี่เหลี่ยมสีมวงและสี่เหลีย่มสีขาวอยางละ 1 รูป 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.1 

สรางสี่เหลี่ยมสีมวงโดยใช 

Rectangle Tool ที่ Toolbox 

ภาพท่ี 4-102 Rectangle Tool ที่ Toolbox 
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คลิกที่ Artboard หน่ึงคร้ัง จะปรากฏหนาตาง Create Rectangle ในหนาตางบอกขนาด

ของความกวางและความสูงที่ไดกำหนดขนาดไวที่ Option bar  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-103 Option bar กำหนดรายละเอียดของสี่เหลี่ยมสีมวง 

กำหนดคาให Fill เปนสีมวง ความกวางของสี่เหลี่ยม = 1100 pixel ความสูง = 140 pixel 1.2 

ภาพท่ี 4-105 สี่เหลี่ยมสีมวงที่สรางสำเร็จ 

ภาพท่ี 4-104 หนาตางแสดงขนาดของแถบขอความที่ตองการสราง 

1.4 

คลิกเลือก      

From Center 

จากน้ันคลิกปุม OK 

1.3 

หากขนาดไมถูกตอง 

สามารถแกไขไดใน

หนาตางน้ี 
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คลิกที่ Artboard หน่ึงคร้ัง จะปรากฏหนาตาง Create Rectangle ในหนาตางบอกขนาด

ของความกวางและความสูงที่ไดกำหนดไวที่ Option bar 

 

 

 

 

 

 

 

 

ภาพท่ี 4-107 Option bar กำหนดรายละเอียดของสี่เหลี่ยมสีขาว 

กำหนดคาให Fill เปนสีขาว ความกวางของสี่เหลี่ยม = 1100 pixel ความสูง = 10 pixel 1.6 

ภาพท่ี 4-108 หนาตางแสดงขนาดของแถบขอความที่ตองการสราง 

 

1.8 

คลิกเลือก From Center 

จากน้ันคลิกปุม OK 

1.7 

หากขนาดไมถูกตอง 

สามารถแกไขไดใน

หนาตางน้ี 

ภาพท่ี 4-106 Rectangle Tool ที่ Toolbox 

1.5 

สรางสี่เหลี่ยมสีขาวโดยใช 

Rectangle Tool ที่ Toolbox 
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2. เลื่อนสี่เหลี่ยมสีขาวลงมาแบงสี่เหลี่ยมสมีวงออกเปน 2 สวน โดยใหดานบนมีพื้นที่เยอะกวา

ดานลาง เพื่อแบงชองระหวางชื่อ – นามสกุลและตำแหนงผูรวมงาน  

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-109 สี่เหลี่ยมสีขาวที่สรางสำเร็จ 

ภาพท่ี 4-110 สี่เหลี่ยมสีขาวและสีมวง 

ภาพท่ี 4-111 Move Tool สำหรับเคลื่อนยายสี่เหลี่ยม 

2.1 

ใช Move Tool         

ในการเคลื่อนยาย 
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ภาพท่ี 4-112 การเคลื่อนยายสี่เหลี่ยมสีขาว 

2.2 

เลือก Layer สี่เหลี่ยมสีขาวและสมีวงเพื่อทำ

การปรับรูปทรงใหเปนสี่เหลี่ยมเปยกปูน 

ภาพท่ี 4-113 เลือก Layer สี่เหลี่ยมที่ตองการปรับรูปทรง 

ภาพท่ี 4-114 คำสั่ง Skew ที่ Menu Bar -> Edit 

ใชคำสั่ง Menu Bar -> Edit -> 

Transform -> Skew เพื่อปรับรูปทรง 

2.3 
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3. พิมพขอความชื่อหรือตำแหนงหนาที่ของผูรวมงาน ใหชื่อและนามสกุลอยูในชองสีมวงดานบน 

ตำแหนงและหนาที่อยูที่ชองสีมวงดานลาง กำหนดใหตัวอักษรที่ใช คือ DB Chidlom X  Style 

Bold สีขาว 

 

 

 

 

 

 

 

 

ภาพท่ี 4-116 สี่เหลี่ยมเปยกปูนที่สรางสำเร็จ 

ภาพท่ี 4-115 คลิกจุดตรงกลางเพื่อปรับรูปทรงของสี่เหลี่ยมผืนผาใหเปนสี่เหลี่ยมเปยกปูน 

2.4 
คลิกคางที่จุดตรงกลางดานบน เลื่อนไปทางขวา

จนไดองศาที่ตองการ จากน้ันกด Enter หน่ึงคร้ัง 

3.1 

คลิกเลือก 

Horizontal Type Tool 

ภาพท่ี 4-117 Horizontal Type Tool 
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เลือก Horizontal Type Tool อีกคร้ังเพื่อสรางขอความตำแหนงหรือหนาที่ของผูรวมงาน 

โดยกำหนดรายละเอียดของตัวอักษรที่ Option bar  ดังน้ี 

 

 

 

 

 

 

 

 

ภาพท่ี 4-118 Option bar กำหนดรายละเอียดของตัวอักษร 

กำหนดรายละเอียดของตัวอักษร ดังน้ี รูปแบบของตัวอักษร เลือก DB Chidlom X 

สไตล Bold ขนาดตัวอักษร 65 pt 
3.2 

ภาพท่ี 4-119 ชื่อและนามสกุลของผูรวมงาน 

พิมพชื่อ-นามสกุลของผูรวมงาน  3.3 

รูปแบบของตัวอักษร เลือก DB Chidlom X สไตล Bold ขนาดตัวอักษร 42 pt 

กำหนดใหรูปแบบของตัวอักษรอยูตรงกลางและใหตัวอักษรมีสีขาว 
3.4 

ภาพท่ี 4-120 Option bar กำหนดรายละเอียดของตัวอักษร 



98 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-121 พิมพตำแหนงหรือหนาที่ของผูรวมงาน 

พิมพตำแหนงหรือหนาที่ของผูรวมงาน 3.5 

ยายขอความโดยใช Move Tool  3.6 จัดแตงขอความใหสวยงามเหมาะสมโดย

ใช Character Panel 
3.6 

ภาพท่ี 4-122 ยายและจัดแตงขอความใหเหมาะสมดวย Move Tool และ Character Panel  

ภาพท่ี 4-123 กราฟกแถบชื่อผูรวมงานที่จัดทำสำเร็จ 
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ภาพท่ี 4-124 ตัวอยางกราฟกแถบชื่อผูดำเนินรายการ กิจกรรมปฐมนิเทศนักศึกษา     

                  ในการถายทอดสดผาน Facebook live 

 

ภาพท่ี 4-125 ตัวอยางกราฟกแถบชื่อวิทยากรในการสัมมนาผาน Facebook live 
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4.5 การบันทึกไฟลภาพกราฟก 

 เมื่อจัดทำภาพกราฟกสำเร็จ ใหทำการบันทึกไฟลภาพกราฟกเพื่อนำไปใชงาน โดยขั้นตอนในการ

บันทึกไฟลภาพมีดังน้ี 

1. การบันทึกไฟลภาพกราฟกสำหรับภาพพักหนาจอ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-126 คำสั่ง save as ที่ Menu Bar -> File 

1.1 

ไปท ี ่  Menu Bar -> File -> Save 

As จะปรากฏหนาตาง Save As 

ภาพท่ี 4-127 ต้ังชื่อไฟลภาพ 

1.2 

ตั้งชื ่อไฟลเปนภาษาอังกฤษเพื่อ

ปองกันขอผิดพลาดในเรื่องภาษา

ของเครื่องสลับสัญญาณภาพและ

เสียง ในตัวอยางนี้ขอตั ้งช ื ่ อวา 

Fashion 



101 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-128 เลือกนามสกุลไฟล 

1.3 

ในชอง Save as type ให เล ือก

เปน TIFF (*.TIF/*.TIFF) 

ภาพท่ี 4-129 เลือกสถานที่จัดเก็บไฟล 

1.5

1.4

เลือกสถานที่

จัดเก็บไฟล 

คลิก Save  
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จะปรากฏหนาตาง TIFF Option 

 

 

 

 

 

 

 

 

 

   

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-130 หนาตาง TIFF Option 

1.6 

คลิก OK  

ภาพท่ี 4-131 ภาพพักหนาจอที่บันทึกสำเร็จ 
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2. การบันทึกไฟลภาพกราฟกสำหรับแถบชื่องานและแถบชื่อผูรวมงาน 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-132 คำสั่ง save as ที่ Menu Bar -> File 

2.1 

ไปที่ Menu Bar -> File -> Save As 

ภาพท่ี 4-133 ต้ังชื่อไฟลภาพและนามสกุลของไฟล 

 

2.2 

ต้ังชื่อไฟลภาพและเลือก

นามสกุลไฟลเปน TIFF 

(*.TIF/*.TIFF) 
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ภาพท่ี 4-134 เลือกสถานที่จัดเก็บไฟล 

2.4 

2.3 

เลือกสถานที่

จัดเก็บไฟล 

คลิก Save  

ภาพท่ี 4-135 หนาตาง TIFF Option 

 

2.6 คลิก OK  

คลิกเลือก Save Transparency เพื่อบันทึกแบบพื้นหลังโปรงใส  

 

2.5 

จะปรากฏหนาตาง TIFF Option 
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4.6 การประเมินและติดตามผลงาน 

 เมื่อผลิตกราฟกสำหรับการถายทอดสดสำเร็จ จะนำเสนอกราฟกตอหัวหนางานเพื่อพิจารณาอนุมัตินำ

ภาพกราฟกเขาเคร่ืองสลับสัญญาณภาพและเสียง เตรียมพรอมสำหรับการถายทอดสดผานอินเทอรเน็ตตอไป 

และหลังจากการถายทอดสดผานระบบอินเทอรเน็ตเสร็จสิ้น จะมีการประชุมสรุปผลการดำเนินงานเพื่อหา

ขอบกพรองและดำเนินการแกไขในคร้ังถัดไป 

 

 

ภาพท่ี 4-136 แถบชื่อรายการที่บันทึกสำเร็จ 
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บทที่ 5 

ปญหา อุปสรรคและขอเสนอแนะ 

   ในการผลิตภาพกราฟกในการถายทอดสดผานระบบอินเทอรเน็ต กลุมพัฒนานวัตกรรมและเทคโนโลยี

การศึกษา สำนักวิทยบริการและเทคโนโลยีสารสนเทศ มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ผูจัดทำคูมือ

การผลิตภาพกราฟกในการถายทอดสดผานระบบอินเทอรเน็ตไดทำการรวบรวมปญหา อุปสรรคและแนว

ทางการแกไขปญหาจากการปฏิบัติงานพรอมทั้งขอเสนอแนะ โดยมีขอสรุปดังน้ี  

5.1 ปญหาอุปสรรค 

   5.1.1 ปญหาการปฏิบัติงานดานการรวบรวมขอมูล  

  1)  ปญหาการติดตอขอดำเนินการถายทอดสดอยางกะทันหัน 

  2)  ปญหาผูจัดงานไมไดใหรายละเอียดงานที่ชัดเจน 

  3)  ปญหาผูจัดงานเปลี่ยนแปลงรายละเอียดของงานโดยไมแจงใหทราบ 

 5.1.2 ปญหาการปฏิบัติงานดานการผลิตภาพกราฟก 

  1) ปญหาการใชงานโปรแกรม Adobe Photoshop แลวหนาจอคาง ไมสามารถทำงานได 

  2) ปญหาเคร่ืองมือหายไปจาก Toolbar 

  3) ปญหาการบันทึกไฟลสำหรับเคร่ืองสลับสัญญาณภาพและเสียงที่แตกตางกัน 

 5.1.3 ปญหาการปฏิบัติงานดานอุปกรณการทำงาน 

1) ปญหาไมปรากฏ Flash Drive ในเคร่ืองสลับสัญญาณภาพและเสียง 
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5.2 แนวทางการแกไขปญหา  

 

ปญหาและอุปสรรคในการปฏิบัติงาน แนวทางการแกไขปญหา 

1) ปญหาผูจัดงานติดตอขอดำเนินการถายทอดสด

อยางกะทันหัน 

มีการติดตอขอใหดำเนินการถายทอดสดอยาง

กะทันหัน ทำใหไมสามารถรวบรวมขอมูลไดทัน และ

ทำใหการผลิตภาพกราฟกเกิดความผ ิดพลาดใน

รายละเอียดของกราฟกชื่อผูรวมงานได 

 

 

 ติดตอประสานงานเจาหนาที่ที ่รับผิดชอบ

เพื่อขอขอมูลและทำการตรวจสอบขอมูล 2 รอบทุก

คร้ังกอนการผลิตกราฟก 

2) ปญหาผูจัดงานไมไดใหรายละเอียดงานท่ีชัดเจน 

ผูจัดงานไมไดแจงรายละเอียดที่นอกเหนือจากชื่อ

งานใหทราบ เชน รายละเอียดของผูเขารวมงาน ชื่อ

ตำแหนง เปนตน ทำใหบางคร้ังไมสามารถผลิตกราฟก

ไดครบ 

    

  ติดตอกับเจาหนาที ่ประสานงานเพื ่อขอ

รายละเอียดตาง ๆ ทุกคร้ัง เพื่อใหไดขอมูลที่ถูกตอง 

ครบถวน 

3) ปญหาการเปลี่ยนแปลงรายละเอียดของงานโดย

ไมแจงใหทราบ 

ผูจัดงานไมไดแจงการเปลี่ยนแปลงรายละเอียดให

ทราบ เชน มีการเปลี่ยนแปลงผูดำเนินรายการ หรือ

เปลี่ยนประธานในพิธี ทำใหกราฟกที่จัดทำไมสามารถ

นำขึ้นถายทอดสดได  

 

     

 

 ตรวจสอบขอม ูลกับผูจ ัดงานตั ้ งแต  การ

ประสานงานคร้ังแรกจนถึงกอนการถายทอดสด เพื่อ

ตรวจสอบรายละเอียดของขอมูลใหตรงกันอยูเสมอ 

 

 

 

 

 

 

 

ตารางท่ี 5-20 ปญหาการปฏิบัติงานดานการรวบรวมขอมูล 
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ปญหาและอุปสรรคในการปฏิบัติงาน แนวทางการแกไขปญหา 

1) ป ญหาการใช  ง านโปรแกรม Adobe 

Photoshop แลวหนาจอคาง ไมสามารถ

ทำงานได 

 เ ม ื ่ อ เป  ด ใ ช  ง านโปรแกรม  Adobe 

Photoshop แลวหนาจอคาง ไมสามารถทำงาน

ตอได หรือกำลังใชงานโปรแกรมแตไมสามารถ

ทำงานตอได หนาจอเบลอ มีสัญลักษณวงกลมวิ่ง

วนไปมา 

 

 

 

 

 

 

 

 

  

 

 

 ใหทำการกดที่คียบอรดของคอมพิวเตอรพรอม

กัน ดังนี ้   Ctrl + Alt + Delete หนาจอแสดงภาพจะ

ปรากฏคำสั่ง เลือก Task Manager หนาตางของ Task 

Manager จะปรากฏขึ ้น หนาตางจะแสดงสถานะการ

ทำงานของโปรแกรมตาง ๆ ที ่ไดเป ดไว  ให ดูท ี ่แถบ

โปรแกรม Adobe Photoshop ว าแถบสถานะข อง

โปรแกรมมีการตอบสนองหรือไม หากมีการตอบสนอง ให

รอเน่ืองจากโปรแกรมกำลังทำงาน แตถาหากโปรแกรมไม

มีการตอบสนอง โดยมีคำวา Not Responding ปรากฏ

ขึ ้น ให คล ิกเมาสเล ือกโปรแกรม Adobe Photoshop 

แลวคลิก End task ที่มุมลางซาย เพื่อออกจากโปรแกรม 

แลวใหเปดโปรแกรมอีกคร้ังหรือรีสตารทเคร่ืองกอนเปดใช

โปรแกรม Adobe Photoshop 

2) ปญหาเคร่ืองมือหายไปจากหนาจอ 

 ในการใช โปรแกรมบางครั ้งอาจไปกด

โดนปุมคียล ัดทำใหเครื่องม ือหายไป หรือเปด

โปรแกรมแลวเคร่ืองมือหายไปจากหนาจอ ทำให

ไมสามารถทำงานได 

 

 

 

 ทำการคืนคาเริ ่มตนของแถบเครื่องมือ โดยไปที่ 

Menu Bar เลือก Edit -> Toolbar -> Restore Defaults 

 หรือบางคร้ังเกิดจากการเลือกใช Workspace ไม

ตรงกับงานใหทำการรีเซ็ตหรือสลับ Workspace โดยไปที่ 

Menu Bar เ ล ื อก  Window -> Workspace - > เ ล ื อก 

Essentials (Default) หรือ Reset Essentials 

3) ปญหาการบันทึกไฟลสำหรับเครื่องสลับ

สัญญาณภาพและเสียงท่ีแตกตางกัน 

 เนื่องเครื่องสลับสัญญาณภาพและเสียง

แตละเครื่องที่ใช มีการทำงานกับภาพกราฟกที่

แตกตางกัน ทำใหขั ้นตอนการผลิตแตกตางกัน

 

  

 สอบถามการใชเคร่ืองสลับสัญญาณภาพและเสียง

จากผูรับผิดชอบในการถายทอดสดทุกครั้ง เพื่อปองกัน

การจัดทำภาพผิดประเภท 

ตารางท่ี 5-21 ปญหาการปฏิบัติงานดานการผลิตภาพกราฟก 
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ปญหาและอุปสรรคในการปฏิบัติงาน แนวทางการแกไขปญหา 

ออกไป หากจัดทำผิดประเภทจะไมสามารถใช

งานภาพกราฟกได 
 

 

 

ปญหาและอุปสรรคในการปฏิบัติงาน แนวทางการแกไขปญหา 

1) ปญหาไมปรากฏ Flash Drive ในเคร่ืองสลับ

สัญญาณภาพและเสียง 

 เมื่อเสียบ Flash Drive เพื่อทำการ Import 

ไฟลภาพกราฟกลงเครื่องสลับสัญญาณภาพและ

เส ียง Flash Drive ไม ปรากฎในเครื ่อง ทำใหไม

สามารถ Import ไฟลภาพได 

     

 

 

 Format Flash Drive ด  ว ย เ ค ร ื ่ อ ง ส ลั บ

สัญญาณภาพและเสียงกอนการบันทึกไฟลภาพลง 

Flash Drive ดวยเครื่องคอมพิวเตอร จากนั้นจึงทำ

การ Import ไฟลภาพกราฟก เข าส ู  เครื ่องสลับ

สัญญาณภาพและเสียง 

 

 

5.3 ขอเสนอแนะ 

 จากปญหาและอุปสรรคที่เกิดขึ้นในการผลิตภาพกราฟกในการถายทอดสดผานระบบอินเทอรเน็ต 

ของกลุมพัฒนานวัตกรรมและเทคโนโลยีการศึกษา สำนักวิทยบริการและเทคโนโลยีสารสนเทศ มหาวิทยาลัย

เทคโนโลยีราชมงคลพระนคร ขอสรุปแนวทางหรือวิธีการปรับปรุงประสิทธิภาพในการการผลิตภาพกราฟกใน

การถายทอดสดผานระบบอินเทอรเน็ต ดังน้ี 

1) ในการรวบรวมขอมูลควรประสานงานกับเจาหนาที่ผู จัดงานทุกครั้ง เพื่อใหไดขอมูลที่ถูกตอง 

ครบถวน 

2) ศึกษาการทำงานของโปรแกรม Adobe Photoshop เพิ่มเติม เพื่อหาทางแกไขเมื่อตัวโปรแกรม

เกิดปญหาในการทำงาน 

ตารางท่ี 5-22  ปญหาการปฏิบัติงานดานอุปกรณการทำงาน 



110 
 

3) ศึกษาการทำงานของเคร่ืองสลับสัญญาณภาพและเสียงเพื่อลดเวลาในการทำงาน เน่ืองจากเคร่ือง

สลับสัญญาณภาพและเสียงแตละรุนมวีิธีการทำงานที่แตกตางกัน รูปแบบของไฟลกราฟกที่จึง

แตกตางกัน 

4)  ศึกษาหาความรูจากแหลงขอมูลตาง ๆ เพิ่มเติม เพื่อนำความรูมาทบทวนและปรับปรุงการ

ปฏิบัติงาน 
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